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About

Helpinator is a help authoring tool for teams and individuals who document their software project themselves. It’s relatively inexpensive and not as bloated as big tech writing packages.

Helpinator is a single source tool. You can compile CHM, PDF, RTF, DOCX, WebHelp (Classic and New WebHelp2), Knowledge Bases, Mobile,** GitHub-flavored Markdown**, Printed Manuals, EPUB and MOBI ebooks, JavaHelp, OracleHelp, HelpGUI, LeanPub, DocBook, DITA, ASCIIDoc, reStructuredText, MajorMindHelp, LiteHelp and plaintext readme all from single source. You can even create software documentation WordPress themes and publish your online documentation to WordPress!

Helpinator is a WYSIWYG tool. Write content in friendly environment.

Helpinator is multilingual. You can have as many project languages as you wish. Work with any translation service you wish using “XML Import/Export.”

Helpinator has a set of unique features like embeddable step-by-step guides, FAQs and self-checkup quizzes.

Major Mind Software provides MajorMindHelpViewer and LiteHelpViewer free of charge if your content was generated using Helpinator.

There’s a features tour on our website:

https://www.helpinator.com/helpinator.html [https://www.helpinator.com/benefits.html]





          

      

      

    

  

    
      
          
            
  
Benefits

Check out the complete list of benefits here:

https://www.helpinator.com/benefits.html





          

      

      

    

  

    
      
          
            
  
Tutorial

This tutorial will show you how to create a simple help file for your application using Helpinator Help Authoring Tool. It covers basic steps without drilling deep into advanced features, so you will get a clear understanding of what Helpinator is about without unnecessary information.

In this tutorial we’ll create a help file for another our product called ” MiniKanban [https://www.minikanban.com]”:

[image: _images/tutorialminikanban.png]
MiniKanban tool





          

      

      

    

  

    
      
          
            
  
Starting a new project

When you run Helpinator you see “Welcome” screen with links to documentation, blog and most common actions. Click on the “New Project” link.

[image: _images/newproject0.png]
New project

“New project” dialog appears.

[image: _images/tutorialnewprojectgeneral.png]
New project - General tab

Enter project title here. If you plan to create multi-lingual project, it’s a good time to click “Add languages” and select additional languages for this project.

Now select “Topics and keywords” tab. Enter topic titles and basic keywords. Don’t worry if you can’t think of any right now - you’ll be able to add them at any time.

[image: _images/tutorialnewprojecttopics.png]
New project - topics and keywords

On “Templates” tabs you can select predefined templates for different types of documentation. For now we’ll leave default settings there.

When everything is ready click “OK”. Helpinator opens up newly created project.

Now let’s select “Variables” tab and enter your product’s and company name, version and year of the release. The first step is done.

[image: _images/tutorial-project-variables.png]
Project variables





          

      

      

    

  

    
      
          
            
  
Capturing screenshots

Helpinator allows you to capture screenshots and automatically create topics with captured screenshots. Helpinator stores screenshots to the project’s image library where you can manage/edit/update imges easily.

First select “Screenshots” node in the project tree view.

[image: _images/tutorialscreenshot1.PNG]
Screenshots - General tab

[image: _images/tutorialscreenshot2.PNG]
Screenshots - Create topics and guides.

[image: _images/tutorialscreenshot3.PNG]
Screenshots - Select what to capture.

Make required settings as shown above and click “Start”. Now when you press hotkey combination Helpinator captures active window and stores it to the image library. We’ll capture screenshots of main form, progress form and log.

Let’s check created topics:

[image: _images/tutorialscreenshotcreatedtopics.PNG]
Topics created by screenshot tool

Newly added topics have the name of the captured window as a title, and a reference to the captured image stored in the image library.

Now, let’s reorder created topics and and move them under “UI” node. Just drag and drop them to the “UI” node, then rearrange using “up” and “down” arrows on the toolbar.

[image: _images/tutorialscreenshotrearrtopics.PNG]
Rearrange topics

Let’s take a look at the library. Captured images are now there under “ui” category.

[image: _images/tutorialscreenshotimagelib.PNG]
Image library





          

      

      

    

  

    
      
          
            
  
Adding callouts

Now let’s add some callouts to the screenshots. Select an image to work on take a look at shapes toolbar.

Select shape style (we use “Red and Yellow” here). Click on rectangle shape on the toolbar and draw it where you want callout to appear. Now select “Arrow” shape and connect rectangle with a target element, in our case the toolbar buttons. Double click the rectangle and enter text into “Caption” field.

[image: _images/tutorialimagesactivateeditor.PNG]
Activate editor

[image: _images/callout-add-caption.png]
Add caption





          

      

      

    

  

    
      
          
            
  
Writing topics

Now let’s write some introductory text.

[image: _images/tutorial-editor-1.png]
Topic editor.

Suppose our users live in a perfect world of sunshine and rainbows and never knew anything about satan. We need to explain this term. And again Helpinator is here to save you, it has built-in Glossary manager.

[image: _images/tutorialglossary.PNG]
Glossary

In the “Add Glossary Terms” dialog click on “Import k/w”, this will import project’s keywords into glossary.

[image: _images/add-glossary-terms-empty.png]
[image: _images/add-glossary-terms.png]
Add glossary terms.

Now you can write definitions for the terms added.

[image: _images/glossary-write-text.png]
Write glossary term definition.

Let’s go back to the topic editor and create a hyperlink for the glossary term.

[image: _images/tutorialeditorbeforehyperlink.PNG]
Inerting a hyperlink

In the “Insert hyperlink” dialog select the term to link to.

[image: _images/tutorial-editor-glo-hyperlink.png]
Insert hyperlink.

[image: _images/tutorial-editor-after-hyperlink.png]
After hyperlink was inserted

Return to the topic editor. Now let’s insert a “Warning” aside using the toolbar button. Later we will see how it will be rendered in the output.

[image: _images/tutorialinsertaside.PNG]
Insert aside





          

      

      

    

  

    
      
          
            
  
Creating a tutorial (a step-by step guide

Helpinator has built-in tutorial maker, that allows you to make tutorials from images in the project image library.

First off we need to prepare images for our tutorial. We already captured all application dialogs but added callouts to them that describe UI elements, not the tasks we need to document. So we’ll use another Helpinator’s unique feature and create “cloned” images from the images already in the library. This will allow us to add callouts exactly for our tutorial.

We are about to create a step-by-step guide that shows how to add a new task to the board.

For this purpose we will add several clones of the image that contains screenshot of “Add a task” dialog. This dialog has a number of edits and switches, so we will have to split the explanation into several steps. However it’s impractical to use different images with the same screenshot. And it’s hard to maintain. Helpinator allows to create “cloned” images of the same donor, so there’s no need to manage more than one copy and we will need to update just one image when the dialog changes.

[image: _images/tutorialimagelibaddclone.PNG]
Manage images add clone

“New cloned image” dialog allows to add several clones of a donor image at once and store them to selected category.

[image: _images/tutorialnewclonedimages.PNG]
New cloned images

Now we can add callouts to the images of our tutorial on every step.

[image: _images/tutorialimgaddcallouts.PNG]
Add callouts.

[image: _images/tutorialimgaddcallouts2.PNG]
Callouts for attachments.

[image: _images/tutorialimgaddcallouts3.PNG]
Callouts for checklists.

Now we can go and create a tutorial itself.

[image: _images/tutorialaddguide.PNG]
Manage guides

[image: _images/tutorialaddguidedialog.PNG]
Add guide dialog

[image: _images/tutorialaddstepimages.PNG]
Step images

By default tutorial steps have the same names as the images selected. We need to rename them and place in correct order.

[image: _images/tutorialguiderenamesteps.PNG]
Rename and reorder steps.

Now you can write step text into the field below the step image.

[image: _images/tutorialguidewritetext.PNG]
Write step text

After all step texts are ready we can insert a placeholder for our tutorial into a corresponding topic. Topic named “Tutorial” in our case.

[image: _images/tutorialinsertguide.PNG]
Insert guide using a toolbar

[image: _images/tutorialguideplaceholder.PNG]
Guide in topic editor





          

      

      

    

  

    
      
          
            
  
Compiling a help file

OK, here we go. Everything is ready and we can now see our help file in all it’s glory. We are going to compile a LiteHelp help file at this step. LiteHelp is a lightweight portable help system for desktop Windows apps created by Major Mind Software as a replacement for CHM (HTML Help).

[image: _images/tutorialcompilelitehelp.PNG]
Compile LiteHelp

Below is the “Warning” aside, rendered with exclamation icon and yellow background.

[image: _images/tutoriallitehelpaside.PNG]
“Warning” aside in LiteHelp.

Our step-by-step guide as a slideshow with navigation.

[image: _images/tutoriallitehelpguide.png]
Step-by-step guide in LiteHelp

[image: _images/tutoriallitehelpglossary.png]
Glossary in LiteHelp





          

      

      

    

  

    
      
          
            
  
Support

Registered users of Helpinator - please submit your requests to the support helpdesk:

http://www.majormind.com/helpdesk





          

      

      

    

  

    
      
          
            
  
Order

Check this page for purchase info:

http://www.helpinator.com/order.html

Note that licenses in packs are cheaper than individual licenses.

You will receive your activation key within minutes. In case the key didn’t arrive on time:


	Check out “Spam” folder


	Contact support with your Order ID.








          

      

      

    

  

    
      
          
            
  
How to…

This sections contains quick guides on how to perform most common help authoring tasks.





          

      

      

    

  

    
      
          
            
  
Start a new project


	Click “New project”




[image: _images/newproject0.png]
Click “New project” on the toolbar on in the welcome screen


	Adjust General Settings




[image: _images/newproject1.png]
At this step you can select project default language and additional languages. You can also select storage mode and path to save your new project to.


	Add Topics and Keywords




[image: _images/newproject2.png]
Here you can add some topics and keywords to start new project with. Use TABs for new levels.


	Add Images




[image: _images/newproject3.png]
If you already have some captured screenshots you can add them to your project at this step. Click “Add Images” and select image files. You can also check “Add topics” to add new topics for each of the added images.


	Select Templates




[image: _images/newproject4.png]
Select templates for all supported formats. You can select from built-in templates or choose your own template stored outside of Helpinator installation.





          

      

      

    

  

    
      
          
            
  
Import existing documentation


	Run “Convert to Helpinator 3 Project”




[image: _images/import.png]

	Select source type




[image: _images/import1.png]
First of all, select what you want to import.


	Select source files




[image: _images/import2.png]
Select source files (in case of old Helpinator project or CHM) OR source folder (in case of HHP and DOC/TXT/HTML files import).


	Select destination project storage mode




[image: _images/import3.png]
Select destination project storage mode. Single file mode is more compact while “Multiple files” mode is good for version control systems - you can check in only those files that were altered, not entire project.


	Enter destination path




[image: _images/import4.png]
Select path to save new project with imported data to.


	Select default project language




[image: _images/import5.png]
Select default destination project file. You can add more languages later.


	Click “Run”




[image: _images/import6.png]
Clcick “Run” and wait for the process to finish. Now you can open destination file in Helpinator.

Note that import creates topics tree according to the order of file names, you’ll have to set the proper order of topics by yourself. Read  this topic to know how to do it quickly.





          

      

      

    

  

    
      
          
            
  
Capture screenshots


	Select “Screenshots” node




[image: _images/capturescreenshots.png]

	Set up general options




[image: _images/capturescreenshots0.png]
Select wether you want to capture new image or REcapture (update) existing one. You can also specify image name mask, category to store it to and image format.


	Create topics and guides




[image: _images/capturescreenshots1.png]
Check whether you want to create a new topic for captured image, append it to an existing topic, create new step-by-step guide or append to existing guide.


	Additional capture options




[image: _images/capturescreenshots2.png]
You can select to capture only active window, entire desktop, area around mouse cursor, capture mouse pointer and background around capture window with effects.





          

      

      

    

  

    
      
          
            
  
REcapture screenshots

If you store all your screenshots in the image library of your project you can easily recapture screenshots. This saves you a lot of time because you don’t need to capture screenshots, find topics that you need to update and insert new images instead of old ones. With Helpinator you only need to select “REcapture” mode in the screenshot tool and select image from the library to recapture. Note that callouts remain the same, only image itself changes.

[image: _images/recapture.png]
Recapture a Screenshot





          

      

      

    

  

    
      
          
            
  
Add annotations to screenshots

You can add callouts and annotations to the images stored in the image library. Select an image and click “Tools->Activate shape editor”.

[image: _images/editimage-shape.png]
Activate Shape Editor

Then select color style from “Style” selector and add any shape, arrow or callout you like.

[image: _images/editimage.png]
Add callouts





          

      

      

    

  

    
      
          
            
  
Quickly update screenshots when UI changes

Helpinator has three main features that help you to update screenshots quickly:


	Image Library. When you store all screenshots in the image library you don’t need to browse through all topics to find screenshots that you need to alter.


	Screeshot REcapture. This feature allows you to REcapture screenshots that are stored in the image library. Image name remains the same as well as added callouts/annotations.


	“Cloned” Images. Clones share the same image with “donor” but each has it’s own callouts/annotations. When UI changes you only need to update “donor” images and Helpinator updates clones automatically.








          

      

      

    

  

    
      
          
            
  
Create step-by-step guides


	Prepare images




[image: _images/imagelibtools.png]
Prepare images for your guide. You can add existing images to the image library, capture some screenshots or create cloned images. Add callouts using image editor to emphasize meaning of the corresponding step.


	Select guides node




[image: _images/guidesselected.png]
Select “Step-by-step Guides” node in the project tree view.


	Click “Add Guide”




[image: _images/guidestools.png]
Click “Add Guide”. New guide dialog box appears.


	Name your guide




[image: _images/guidename.png]
Give appropriate name to your guide. It is recommended to avoid use of spaces and special characters since this name will be used in “SBS” placeholder.


	Create topic




[image: _images/createtopic.png]
Check “Add topic” to automatically add topic with created guide. It will be added as the last topic in the project. You can use project tree drag and drop feature to put it in the correct place.

If you leave it unchecked then you need to manually insert “SBS” placeholder into desired topic.


	Add images




[image: _images/addimages.png]
Click “Add images” button to add images for steps. You will be able to rearrange and rename steps later.


	Select images to add to the guide




[image: _images/selectimage.png]
Select images for steps. Images are taken from the project’s image library. Check as many images as you wish.


	List of steps




[image: _images/steps.png]
The list of steps is at the left top corner of the guide editor. On top of the list there are tool buttons to edit it.


	Give short names to each step




[image: _images/namesteps.png]
Click “Rename” to give appropriate titles for steps.


	Put steps in the correct order




[image: _images/reordersteps.png]
Reorder steps using “Up” and “Down” buttons.


	Add descriptive text for each step




[image: _images/addtext.png]
Write some descriptive text for each step. Be short, image should say for itself.


	Set up guide options




[image: _images/guideoptions.png]
Guide options are at the left bottom row. Here you can select whether you want to add step numbers to step images, select color scheme to use for step numbers and where they should be located on the step image. Check “Auto size” if you want Helpinator to select size of the HTML box automatically, or set width and height manually.





          

      

      

    

  

    
      
          
            
  
Create CHM help file


	Install HTMLHELP.EXE




[image: _images/createchm5.png]
First of all you need HTMLHELP.EXE (a tool from Microsoft that allows you to compile CHM help files). For your convinience it is packed in the same zip archive with Helpinator.


	Check “HTML-based templates”




[image: _images/createchm10.png]
Check “HTML-based templates” node of the project tree view. It has default.html template for CHM output but you can check for more built-in templates.


	Click “+” to add more CHM templates




[image: _images/createchm6.png]
Click on green plus sign and “Add template” dialog opens.


	Select a template from the drop-down list




[image: _images/createchm7.png]
Select a template from the drop-down list. A preview od compiled topic appears at the bottom. Note that there is “For: CHM” text below template title.


	Select added template from the drop-down list




[image: _images/createchm8.png]
Now you need to activate your template. Select root node in the project tree view, browse to “Templates” tab and select template from the “CHM” drop-down.


	Click “Compile CHM” on the main tool bar.




[image: _images/createchm9.png]
Now you can click “Compile CHM” on the main tool bar and Helpinator will compile a CHM help file for you.





          

      

      

    

  

    
      
          
            
  
Create PDF and printed manuals


	Select “PDF/RTF/Print templates”




[image: _images/createpdf.png]
First of all, let’s check what template you can use for PDF output besides default template in your project.


	Click “Add template”




[image: _images/createpdf1.png]
Currently the list of templates cosists only of “default.rtf”, click “+” sign to add more templates.


	Select new template




[image: _images/createpdf2.png]
“Add template” dialog appears. Now you can select from “Built-in” drop-down list. Template preview at the bottom updates automatically. Note “For: PDF” label below template name.


	Set new templates for PDF and print




[image: _images/createpdf3.png]
Select root node in the project tree view, then “Templates” tab and select new templates for PDF and PRINT. However you can keep “default.rtf” template, if it’s good enough for you.


	Click “Compile PDF”




[image: _images/createpdf4.png]
Now you can click “Compile PDF” or “Print” buttons on the main tool bar to create a pdf file or send output to printer.





          

      

      

    

  

    
      
          
            
  
Create WebHelp


	Select “HTML-based templates”




[image: _images/en-createwebhelp.png]

	Click “Add Template”




[image: _images/en-createwebhelp1.png]

	Check for WebHelp templates




[image: _images/en-createwebhelp2.png]

	Set WebHelp template




[image: _images/en-createwebhelp3.png]
Select root node in the project tree view, then “Templates” tab and set WebHelp template (or leave default.html there).


	Click “Create WebHelp”




[image: _images/en-createwebhelp4.png]
Click “Create WebHelp” button on the main tool bar.





          

      

      

    

  

    
      
          
            
  
Create QtHelp


	Download and install Qt SDK




[image: _images/createqtdownload.png]
Download and install QtHelp SDK if you haven’t already done so.


	Set path to qthelpgenerator.exe




[image: _images/enoptionsqtcompiler.png]
Select Main Menu->Tools->Options and enter “Path to QtSDK BIN folder” where qthelpgenerator.exe is located.


	Select “HTML-based templates”




[image: _images/en-createqt.png]
Select “HTML-based templates” and check there’s a template for QtHelp. Helpinator’s default.html is QtHelp-compatible.


	Click “Add template”




[image: _images/en-createqt1.png]
Click “Add template” if you are not satisfied with default template.


	Check for QtHelp templates




[image: _images/en-createqt2.png]
Select templates that have “For: QTHELP” label.


	Set QtHelp template




[image: _images/en-createqt3.png]
Select root node in the project tree view and browse to “Templates” tab, then select template for QtHelp from the drop-down list or leave default.html.


	Compile QtHelp




[image: _images/en-createqt4.png]
Now you can click “Compile QtHelp” on the main tool bar to compile QtHelp help file.





          

      

      

    

  

    
      
          
            
  
Create JavaHelp and OracleHelp

The following topics cover in details how to compile:

JavaHelp

OracleHelp





          

      

      

    

  

    
      
          
            
  
Create EPUB and MOBI ebooks


	Select “HTML-based templates”




[image: _images/createepub.png]
Select “HTML-based templates” node in the project tree view and check for “epubmobi-default.html” template. If it is in place, proceed to step 5.


	Click “Add template”




[image: _images/createepub1.png]
Click “+” to add epub-mobi template. IF you can see it in the list, you don’t need to add it.


	Select epub-mobi template




[image: _images/createepub2.png]
Select “epub-mobi” template from the list and click “OK”


	Set epub-mobi template




[image: _images/createepub3.png]
Select root node in the project tree view and browse to “Templates” tab, then select “epub-mobi” template from drop-down lists for EPUB and MOBI formats.


	Compile EPUB




[image: _images/createepub4.png]
Now you can click “Compile EPUB” to create epub file. To compile MOBI you need to take some more steps.


	Download KindleGen




[image: _images/createmobikindlegen.png]
To compile MOBI you need to download and install KindleGen - free command-line tool from Amazon that allows to create MOBI ebooks.


	Set path to KindleGen




[image: _images/enoptionskindlecompiler.png]
Select Main Menu -> Tools -> Options and enter path to KindleGen utility.


	Compile MOBI




[image: _images/createepubkindle.png]
Now you can click “Compile MOBI” to create mobi file.





          

      

      

    

  

    
      
          
            
  
Embed Video from YouTube, Vimeo and etc


	Get HTML Embed Code from service provider




[image: _images/embedvideo.png]
First of all you need to get your video embed code from video service provider (YouTube in this case).


	Select “Video” node




[image: _images/embedvideo1.png]
Select “Video” node in the project tree view.


	Click “Add video from YouTube”




[image: _images/embedvideo2.png]
Click “Add video from YouTube, Vimeo…”


	Enter name and embed code




[image: _images/en-embedvideo.png]
Enter name to refer to this video and embed code from service provider.


	Video appears in the video library




[image: _images/en-embedvideo1.png]
Now your video is in project’s video library and you can embed it into topics.


	Click “Insert Video”




[image: _images/embedvideo3.png]
Select a topic to insert video into, place cursor where you want your video to appear and click “Insert Video” on the editor tool bar.


	Placeholder appears




[image: _images/embedvideo4.png]
Video placeholder appears in the position of cursor. Now Helpinator will insert your YouTube video into compiled documentation if the selected output format supports video.





          

      

      

    

  

    
      
          
            
  
Change order and hierarchy of topics quickly

Version 3.11.3 introduces new feature called “Advanced rearrange”. It allows to quickly change order, titles and hierarchy of multiple topics at once. Normally Helpinator allows to change order of topics and their position in the topic tree by dragging and dropping topics in the topic manager. It is good for a topic or two but is very uncomfortable and time-consuming when you need to change places of several topics in a large project (say, after mass-importing html/rtf files).

To activate this feature select “Topics” node and click the button shown on the image below.

[image: _images/rearrange-button.png]
Rearrange topics

It opens up “Advanced rearrange” window. This window is a simple plain text editor with a topics tree converted to it’s plain text representation. Each line has a topic title and topic id in brackets at the end of the line. If a topic is a subtopic, it’s line starts with a TAB (one for level 1 subtopics, two TABS for level 2 and so on).

[image: _images/advanced-rearrange.png]
Advanced Rearrange

What you can do here:

==

==

Cut/Paste topics en masse. Select several lines with your mouse or Shift+cursor, click Ctrl+X to cut them, place cursor into their new location and click “Ctrl+V” to paste.

==

==

Change levels – just insert/remove TABs at the beginning of the line. To move several topics to another level (e.g. to insert TAB into several lines) select them as told above and click “Increase Level”. This will insert TABs into several lines at once. “Decrease level” works the same way.

==

==

Rename topics. It’s OK to change topic titles as long as you keep ID part at the end of each line intact.

What you CAN’T do:

==

==

Change or delete topic IDs. They are used for identification, so it will cause an error.

==

==

Delete topics – to delete topics please use corresponding command of the topic manager. Deleting topics here will cause an error.

==

==

Add new topics – the same as with “Delete topics” issue, use “Add topics” command from the topic manager.





          

      

      

    

  

    
      
          
            
  
Create a FAQ


	Select “FAQ” node




[image: _images/createfaq1.png]
Select “FAQs” node in the project tree view.


	Add a new FAQ




[image: _images/createfaq2.png]
Click “+” sign to add a new FAQ.


	Enter FAQ name




[image: _images/createfaq3.png]
Enter short FAQ name to reference it.


	Add a FAQ section




[image: _images/createfaq4.png]
Click “+” sign under “Sections” group to add a new FAQ section.


	Add a question




[image: _images/createfaq5.png]
Click “+” sign under “Questions” group to add a new question.


	Edit question




[image: _images/createfaq8.png]
Edit question text and answer. Question text is plain text, answer is rich text like any topic.


	Embed




[image: _images/createfaq10.png]
You can embed your newly created FAQ into a topic with FAQ pseudo tag. It will be replaces with an actual FAQ at compile time.





          

      

      

    

  

    
      
          
            
  
Create a Quiz


	Select “Quizzes” node




[image: _images/createquiz1.png]
Select “Quizzes” node in the project tree view.


	Add a new quiz




[image: _images/createquiz2.png]
Click “+” button to add a new Quiz


	Open editor




[image: _images/createquiz3.png]
Double click the newly create quiz to open quiz editor


	Add a question




[image: _images/createquiz4.png]
Click “+” icon to add question, write question text in “Question” tab.


	Set up answers




[image: _images/createquiz5.png]
Select answers numbering, multiple correct answers and how options will be generated.


	Embed into a topic




[image: _images/createquiz6.png]
Embed a quiz into a topic with “QUIZ” tag.





          

      

      

    

  

    
      
          
            
  
Getting Started

This topic will help you to make quick start and learn basics of Helpinator in under a few minutes.

First off, take a look at  UI Overview.

Next, learn Helpinator  Project structure, what types of items does it contain?

Then  start a new project.

And finally know what  formats Helpinator supports and how to compile help files.





          

      

      

    

  

    
      
          
            
  
UI Overview

Helpinator has classical explorer-like UI with open/compile project buttons on the main toolbar and all project items organized in the project tree view.

[image: _images/uioverview.png]
UI Overview





          

      

      

    

  

    
      
          
            
  
Project Structure

The picture below shows Helpinator project structure.

[image: _images/projectstruct.png]
Project Structure

You are not forced to create all items shown above. In fact, you only need some topics and templates to create documentation.





          

      

      

    

  

    
      
          
            
  
Output Formats

Currently Helpinator supports the following output formats:


	MajorMindHelp - our own HTML-based help system


	LiteHelp - our own lightweight help system NOT based on HTML


	SimpleDocServer


	CHM (Microsoft HTML Help)


	PDF (Adobe Acrobat)


	RTF (Rich Text Format)


	DOCX (Word 2010+)


	Classic WebHelp (HTML based with navigation and 3 options: with frames, without frames and single page).


	WebHelp 2 (responsive HTML without frames)


	QtHelp (Qt library native help file format)


	JavaHelp (Java native help file format)


	EPUB - widespread ebook format


	MOBI - Amazon Kindle format.


	OracleHelp - help system from Oracle Inc


	HelpGUI - a lightweight help system for Java


	WordPress CMS


	Github Flavoured Markdown (for readme.md of your projects, Github Wiki and Github pages).


	Knowledge Base


	Mobile (JQuery Mobile)


	Single Page HTML


	LeanPub manuscripts


	reStructuredText - for use with the excellent readthedocs.io service


	ASCIIDoc - if you want to employ the power of ASCIIDoc/ASCIIDoctor documentation generators.


	DITA - established documentation authoring standard with a lot of output formats and tools that support it.


	Docbook - another industry standard documentation format.


	Old good plain text to create good formatted readme.txt for your projects.








          

      

      

    

  

    
      
          
            
  
Project

Project options define global project-wide settings.

[image: _images/projectoptions.png]
Project Options







	Option

	How it works



	Auto generate Context IDs

	Helpinator will generate unique context ID every time you add a new topic or anchor



	Auto Index

	If this option is checked you don’t need to assign keywords to each topic. Just fill the list of project keywords and Helpinator will assign them to topics automatically, based on topic content.



	Auto number topics…

	Helpinator will put sequential topic number in front of topic title when generating help files.






Clicking on “PDF/Print settings” opens up “PDF settings” dialog. First page “General” allows you to define special fields of PDF document.

[image: _images/projectoptions1.png]
General Project Options

The second acts both for PDF and for printed manuals. Here you can define margins, orientation and paper size.

[image: _images/projectoptions2.png]
PDF Settings





          

      

      

    

  

    
      
          
            
  
Variables

Variables play important part in Helpinator project:


	They contain info that changes frequently, like version number.


	They are used in templates to insert product name, version, edition and etc, so you don’t need to alter templates for that kind of stuff.


	They help to control conditional compilation. You can get two different help files from the same source changing one or more variables before compilation.




All variables are located on the “Variables” tab of Project Options.

[image: _images/variables.png]
Variables

“Presets” are the easy way to switch sets of variable values and are especially useful in conditional compilation.

In the example above variable “EDITION” has the value “STD” in the preset named “STANDARD” and “PRO” in the preset named “PROFESSIONAL”. Select active preset before compilation to set variable values.





          

      

      

    

  

    
      
          
            
  
Storage Modes

Helpinator has two storage modes:


	Single-file mode. Everything is in one zip-compatible project file with .hpz extension. Good if you don’t use VCS system or want to deal with one file.


	VCS-friendly mode. In this mode Helpinator stores every item in a separate file (or several files) and updates only changed files. So you don’t need to check-in entire project every time you change something.




Modes are interchangeable. You can zip project folder (with project.xml in the root) and change extension from zip to hpz and work with your project in single-file mode. Or you can extract everything from hpz file and work in VCS-friendly mode.





          

      

      

    

  

    
      
          
            
  
Topics and Content

Topics are the basis of your help project. Topics may contain formatted text, tables, images, code and text snippets, step-by-step guides. Topics have language-specific title, project-wide unique ID, context ID to connect to your app and a list of assigned keywords.

You can assign tasks and notes to topics for advanced management purposes. Topics also may be skipped from output based on a set of conditions.

Topic editor UI is similar to any other text processor UI with some additions related to Helpinator and help authoring in general.





          

      

      

    

  

    
      
          
            
  
Manage Topics

Topic manager resides under “Topics” node of the project tree view.

[image: _images/managetopics.png]
Manage Topics

When you click “Add several topics” separate dialog box appears:

[image: _images/addsevtopics.png]
Add several topics

Here you can add a bunch of topics as children of the selected topic and also with hierarchy. Just start new levels with TAB.





          

      

      

    

  

    
      
          
            
  
Classic Toolbar WYSIWYG Editor

Text authoring UI of Helpinator is similar to any other text processor. It has common text formatting toolbars, as well as Helpinator-specific object insertion commands, like “insert code snippet” and other. It also allows you to apply named text and paragraph styles to  selected text.

Images below show what each toolbar button is for:

[image: _images/eng-ed-toolbar.png]
[image: _images/eng-ed-toolbar2.png]
Below editor area there’s topic settings tab set:

[image: _images/eng-ed-general.png]
Click “…” to open “Topic keywords” dialog. It allows to select from keywords already existing in the project, added new keywords manually or using a list of suggested keywords.

[image: _images/ediytorkeywords.PNG]
[image: _images/keywordseditor2.PNG]
[image: _images/keywordseditor3.PNG]
“ToDo” tab contains simple todo list of tasks assigned to this topic. Later on you can review all tasks assigned to all topics in global tasks manager (“Tasks” node of the project tree view) or using the report “Tasks by topic” that shows a list of tasks grouped by topic.

[image: _images/eng-ed-todo.png]
Notes allows you to write down something related to this topic. This combined with “COMMENT” tag makes a good tool for text reviews.

[image: _images/eng-ed-notes.png]
Sometimes you need different HTML template for a topic (for example, default, title topic, with big company logo). You can select what template to use - default or maybe special template.

[image: _images/eng-ed-template.png]
Anchors allow you to reference certain place in this topic, either using a hyperlink or context-sensitive help call using “Context ID”.

[image: _images/eng-ed-anchors.png]
“Skip topic” tab allows you to skip current topic from output based on:


	Condition - using variables. See “Conditional compilation” for more details.


	Skip from certain formats. For example, when topic contains video, it should be exported to CHM and WebHelp, but not PDF and RTF.


	Skip always - select this mode if this topic is not ready yet.




[image: _images/eng-ed-skip.png]




          

      

      

    

  

    
      
          
            
  
Tabbed Toolbar Editor

Classic editor toolbar is too cluttered and overloaded so we introduced a little bit improved tabbed toolbar that has similar functions, divided into categories. It has 4 tabs: “Write”, “Insert”, “Table” and “Tools”.



“Write” tab has all basic writing functions like fonts, lists and etc.

“Insert” tab allows to insert dedicated content pieces of Helpinator - Screenshots, text snippets, code snippets, step-by-step guides, videos, admonitions, faqs and quizzes.

**”Table” **allows to insert and manipulate tables.

“Tools” tab contains text processing tools like copy-paste, spellchecker and etc.

[image: _images/eng-ed-write.png]
“Write” Tab

[image: _images/eng-ed-insert.png]
“Insert” tab

[image: _images/eng-ed-table.png]
“Table” tab

[image: _images/eng-ed-tools.png]
“Tools” tab





          

      

      

    

  

    
      
          
            
  
Styles

You can add named styles for virtually any object in Helpinator. Global named styles allow you to keep the same formatting everywhere and change the way items look in a matter of few clicks.

[image: _images/styles.png]
Styles





          

      

      

    

  

    
      
          
            
  
Text and Paragraph Styles

[image: _images/textstyle.png]
Text Style

[image: _images/styles1.png]
Paragraph style





          

      

      

    

  

    
      
          
            
  
Table Styles

Table styles allow you to keep the same table formatting in all topics.

[image: _images/styles2.png]
Table Styles

To use table style you can either select it in the “Insert table” dialog  or from “Cell properties” dialog of WYSIWYG topic editor.





          

      

      

    

  

    
      
          
            
  
Shape Styles

Shape styles allow you to define common settings for different shapes that you can add in the  image editor. You can select line styles, colors for lines and background and font settings for text inside shapes.

[image: _images/styles3.png]
Shape Styles

To use created style you can select it from the drop-down list in the image editor toolbar. This style will be used for shapes that you add. To change the style of the selected shape double-click it to open shape properties and select style in the dialog that appear.

[image: _images/selshapestyle.png]
Select shape

[image: _images/selshapestyle1.png]
Select a shape style





          

      

      

    

  

    
      
          
            
  
Guide Styles

Guide styles allow you to change appearance of Step-by-step Guides in compiled documentation. Most of it Helpinator uses only when compiling CHM and WebHelp, PDF/RTF/Printed Manuals do not use “slideshow” effect, so only font settings will be taken into account when compiling them.

[image: _images/styles4.png]
Guide Styles

CSS tab contains highlighted CSS code that will be inserted into HTML-based help output (CHM and WebHelp).

Here you have more control over Guide appearance in this kind of documentation, but be careful.

[image: _images/styles5.png]
CSS of Guide Styles

To use your newly created guide style select it from corresponding drop-down list in the guide options area.

[image: _images/selguidestyles.png]
Assign new style to a guide





          

      

      

    

  

    
      
          
            
  
Manage Glossary

Helpinator allows you to create, manage and reference Glossary of terms specific to your project.

[image: _images/glossary.png]
Glossary

To insert a link to a glossary term use “Glossary” tab in the “Insert Hyperlink” editor dialog:

[image: _images/glo-insert-hyper.png]
Insert a glossary hyperlink





          

      

      

    

  

    
      
          
            
  
Images

There are two ways to use images in Helpinator:


	Regular images, embedded into topics


	Library images, stored in the project’s Image Library and referenced from one or more topics.




The first one is similar to other Help Authoring Tools and text processors

The second is far more efficient from the productivity point of view, since all your images are in one place and you don’t need to browse through project topics to update them when something changes in your program’s UI. Beside that:


	Image Library allows you to add annotations to images, so you can make more understandable help files.


	Image library allows you to create “cloned” images. Clones are exact copies of “donors” and update the same moment you update “donor” image. But they have different annotations, so you can create a bunch of images with different annotations from the same screenshot. Once UI changes you only have to update one image and the rest will be updated automatically!


	Image Library has categories for images, so it is easy to manage a large project with a lot of images in it.


	You can create “step-by-step guides” from images stores in the image library.








          

      

      

    

  

    
      
          
            
  
Managing Images

Image Library UI has a toolbar with commands and tree list of images, organized into categories.

[image: _images/images.png]
Image Library

Toolbar has the following commands:


	Add Image from file


	Rename image (selected images)


	Delete image (selected images)


	Assign new category to selected images


	Resize selected images


	Export selected images


	New blank image


	New cloned image




Add Image from file opens up separate dialog:

[image: _images/addimagefromfile.png]
Add image from file

“Resize selected images” command allows you to resize images that have width in pixels more than selected value. This is useful when you have captured a bunch of screenshots that do not fit browser or PDF page width.

[image: _images/resizeimages.png]
Resize Images

“New blank image” allows you to create an image with user defined size and filled with selected color. Using it and annotations you can create diagrams like this:

[image: _images/projectstruct.png]
Shapes drawn above a blank image

[image: _images/newblankimage.png]
New Blank Image

“Cloned” images are explained in detail in this topic:  “Cloned Images”





          

      

      

    

  

    
      
          
            
  
Image Editor

Helpinator has built-in image editor that allows you to add arrows, boxes with text and other useful content to images in the project’s image library.

Image editor is fairly simple to use. The figure below explains pretty much everything. Select shape style (or “None” if you do not need it), shape on the toolbar and drop it somewhere.

[image: _images/editimage.png]
Image editor explained

The “Tools” menu of the image editor has some handy commands you can use:

[image: _images/editimage-shape.png]
Image editor tools


	Extend image canvas - allows to make a screenshot larger by adding extra blank space.


	Show grid - shows shape alignment grid - disable it if it annoys you.


	Replace Image (From File) - replace the image bitmap/background using the selected file. Shapes will stay intact.


	Replace Image (From Clipboard) - replace the image bitmap/background using the image currently in the Clipboard. Shapes will stay intact.


	Export image - save image to file, with all shapes rendered over bitmap.


	Change active region - allows to define “active” region of the image. Active region limits the area where you can place shapes and allows to apply some effects to the space outside of it (darken, blur, crop).


	Stop changing active region - disables active region resizer.


	Effect for inactive region - allows to select an effect that you want to apply to the area outside of the active region (keep it as is, blur, darken, crop).


	Crop image to active region - crop the image so it will match the defined active region. Basically it is just “Crop” command from any other image editor. Operation is irreversible! Not applicable to cloned images.


	Make this image a clone of… - allows to change the donor of the cloned image or turn the image into a cloned one.


	Unclone - break the link between the clone and donor, the image will no longer update automatically when the donor image updates.








          

      

      

    

  

    
      
          
            
  
Using Images

You can use images in one of the following ways:


	Inside topics or other textual content pieces.


	In step-by-step guides.




Step-by-step guides have their own topic, here we’ll talk about inserting images into topics.

You are not forced to use Image Library, you can add images into topics as in usual text processor, using the toolbar button shown below.

[image: _images/useimage.png]
Insert inline picture

Inserting library images is not very different from it. Click on a toolbar button and select an image from the drop-down list. Note that images are grouped by category.

[image: _images/insertfigure.png]
Insert Screenshot / Figure

Now when you change an image in the image library it is automatically updated in all topics that reference it.

There are other options available:


	“Insert Screenshot / Figure From File…” - use it if you have an image on your hard drive and want to insert in the position of caret and into the project library at the same time.


	“Paste screenshot from Clipboard” - use it if the image is in clipboard, obtained by Ctrl-PrtScr or other screenshot capture tool.


	“Quick search for an image” - allows you to quickly locate image in the project library by it’s name. How it works:




[image: _images/quicksearchforimage.PNG]
Quick search for an image

Type a part of image name into the edit box at the top of the window and it will filter out images that do not match the criteria. Now you can select one or more images with checkboxes and click “Insert” to place them in the position of caret.





          

      

      

    

  

    
      
          
            
  
Cloned Images

Helpinator’s “Image Library” allows you to create “cloned” images. What are they?

Let’s say you have a big complicated tool bar in your application. You need to explain your users how to work with it, what buttons trigger specific actions, all grouped by specific tasks… This probably will require a lot of copies of the toolbar image, each one with it’s own callouts, arrows and text boxes, but all with the same background – application toolbar.

Now suppose that during project evolution toolbar changes significantly – updated icons, some new buttons. Now you need to update a bunch of images to reflect changes in the UI. That could be a nightmare! But not if you use Helpinator’s image library and “cloned” images.

In the following example will’ take a look at one simple but very common situation. Suppose you have a set of images in your project, describing different parts of the toolbar, but all of them contain application name and version in the window title like this:

[image: _images/{264733B0-0907-4710-BF67-CFFF8D2A5163}.png]
One image has callouts for language bar:

[image: _images/{C07702C6-836E-464D-BDB7-3F2906134B7C}.png]
Another for compile buttons, and so on…

[image: _images/{3737ADA8-A871-4A9C-A9D5-BA21C0DDFB78}.png]
We’ll make the first one “donor” image and two other images will be cloned.

[image: _images/newclonedimage.png]
New cloned image

Now suppose application version changes to 3.5. You need to update all those images. Luckily you have only one donor image and two clones, so you only need to update one image.

Select Tools->Replace Image when donor image is open in the editor.

[image: _images/replacebitmap.png]
Replace bitmap

Now all cloned images are updated:

[image: _images/{B9F6839E-6B6B-4073-B60A-3981907DF019}.png]
[image: _images/{24E4B81A-84E6-45BE-9470-B9064C2951C1}.png]
There’s also a handy feature that is called “Active region”. It allows to use only a square portion of the donor image. Define active region and set “Effect for…” to “Crop”.

[image: _images/imageactiveregion.png]
Change active region

Example.

This image is the large donor image. But we do not need it as a whole, more than that, it will be discussed in different topics.

[image: _images/cloneexampledonor.png]
Donor

So we can create two clones and define different active regions for them.

[image: _images/cloneexampleclone1.png]
Clone 1

[image: _images/cloneexampleclone2.png]
Clone 2





          

      

      

    

  

    
      
          
            
  
Paste from Clipboard

If you prefer to use another screenshot capture tool or just Windows PrntScrn built-in function Helpinator allows to quickly add captured screenshot from the Clipboard. Just place the cursor in the topic editor where you want to place the screenshot and click “Ctrl+Alt+V” or select “Paste Screenshot from Clipboard” in the right-click pop-up menu.

“Paste screenshot…” dialog appears. Select image name, format and category, then click “Paste”.

[image: _images/pastefromclipboard.PNG]
Paste from Clipboard





          

      

      

    

  

    
      
          
            
  
How to Work With Video

From version 3.11 Helpinator allows you to embed video into topics. You can embed videos from video service providers like YouTube, Vimeo, DailyMotion or from local video files.

To start working with videos select “Video” node in the project tree view.

[image: _images/embedvideo1.png]
“Video” tree node

If there’s no “Video” node click “Show Videos” on the tree view control bar on the left.

[image: _images/en-workwithvideo.png]
Tree filter for Video

Video manager appears:

[image: _images/en-workwithvideo1.png]
The Video Manager

When you click “+” sign “Add from files” dialog appears. Click “Add files” to select one or more video files to add then click “OK”.

[image: _images/en-workwithvideo2.png]
Add a video from file

When you click on YouTube sign “Add from URL” dialog appears:

[image: _images/en-workwithvideo3.png]
Add video from URL

To insert video placeholder into a topic click on video icon on the topic editor toolbar.

[image: _images/embedvideo3.png]
Insert Video into a topic

Helpinator inserts video placeholder in the position of caret. Now on compile time this placeholder will be replaced with your video.

[image: _images/embedvideo4.png]
Some formats like PDF or printed output do not support video. You can instruct Helpinator to replace video with a library image or a step-by-step guide via image properties.

[image: _images/embedvideo4.png]
Video in a topic editor





          

      

      

    

  

    
      
          
            
  
Step-by-step Guides

Step-by-step guides allow you to document procedures that users have to follow to accomplish certain task. Each guide consists of steps. You can add as many steps as you want, but it’s a good idea to limit yourself to 10-15. Each step has:


	Title


	Descriptive text about actions to perform on this step


	Image from project’s Image Library. You can use plain images/screenshots, but it’s better to  annotate them. If your guide uses lots of similar images with different annotations - then you might want to use  cloned images for steps.




Helpinator stores all guides in a place similar to Image Library.

[image: _images/manageguides.png]
Manage guides





          

      

      

    

  

    
      
          
            
  
How to create a step-by-step guide


	Prepare images




[image: _images/imagelibtools.png]
Prepare images for your guide. You can add existing images to the image library, capture some screenshots or create cloned images. Add callouts using image editor to emphasize meaning of the corresponding step.


	Select guides node




[image: _images/guidesselected.png]
Select “Step-by-step Guides” node in the project tree view.


	Click “Add Guide”




[image: _images/guidestools.png]
Click “Add Guide”. New guide dialog box appears.


	Name your guide




[image: _images/guidename.png]
Give appropriate name to your guide. It is recommended to avoid use of spaces and special characters since this name will be used in “SBS” placeholder.


	Create topic




[image: _images/createtopic.png]
Check “Add topic” to automatically add topic with created guide. It will be added as the last topic in the project. You can use project tree drag and drop feature to put it in the correct place.

If you leave it unchecked then you need to manually insert “SBS” placeholder into desired topic.


	Add images




[image: _images/addimages.png]
Click “Add images” button to add images for steps. You will be able to rearrange and rename steps later.


	Select images to add to the guide




[image: _images/selectimage.png]
Select images for steps. Images are taken from the project’s image library. Check as many images as you wish.


	List of steps




[image: _images/steps.png]
The list of steps is at the left top corner of the guide editor. On top of the list there are tool buttons to edit it.


	Give short names to each step




[image: _images/namesteps.png]
Click “Rename” to give appropriate titles for steps.


	Put steps in the correct order




[image: _images/reordersteps.png]
Reorder steps using “Up” and “Down” buttons.


	Add descriptive text for each step




[image: _images/addtext.png]
Write some descriptive text for each step. Be short, image should say for itself.


	Set up guide options




[image: _images/guideoptions.png]
Guide options are at the left bottom row. Here you can select whether you want to add step numbers to step images, select color scheme to use for step numbers and where they should be located on the step image. Check “Auto size” if you want Helpinator to select size of the HTML box automatically, or set width and height manually.





          

      

      

    

  

    
      
          
            
  
How to use guides in topics

There’s “Insert step-by-step guide” button on the topic editor toolbar.

Click on “Insert step-by-step guide” and select it from the drop-down list.

[image: _images/useguide.png]
Insert a step-by-step guide

When you select a guide, guide placeholder appears in the editor area in the position of cursor.

[image: _images/useguide2.png]
Placeholder for a step-by-step guide





          

      

      

    

  

    
      
          
            
  
Text Snippets

Text snippets are named reusable blocks of formatted text that you can create once and use in many topics. Note that since version 3.19 Helpinator has dedicated content piece called “Aside” and you no longer are forced to use text snippets to create asides.

The picture below shows how to manage text snippets.

[image: _images/managetextsnip.png]
Manage Text Snippets

There are two types of text snippets:


	Simple pieces of formatted text


	Parameterized snippets, that contain special placeholder TEXTFORSNIPPET which Helpinator replaces with text from the topic.




Here’s an example of the second type text snippet:

[image: _images/edittextsnip.png]
Edit text snippet





          

      

      

    

  

    
      
          
            
  
How to use text snippets

In this example we use “warning” box created in previous topic:

This text is for “Warning” box.

[image: _images/usetextsnippet.png]
How it will look like in CHM help file:

[image: _images/usetextsnippet1.png]




          

      

      

    

  

    
      
          
            
  
Code Snippets

Code snippets are portions of code or markup with syntax highlight. Helpinator allows you to manage code snippets using snippet library and embed them into topics using special placeholders. Though Helpinator is not intended to document source code, code snippets allow you to document APIs, HTML/XML samples and other supplementary code.

The picture below shows how to use code snippets manager.

[image: _images/codesnippetmanager.png]
Code Snippet Manager

Code snippet editor allows you to view and edit code snippet with syntax highlighting. You can also change highlighting for the snippet.

[image: _images/codesnippet.png]
Code Snippet





          

      

      

    

  

    
      
          
            
  
How to use code snippets


	Click toolbar button




[image: _images/usesnippet1.png]
Locate “Insert code snippet” button on the topic editor toolbar and click it.


	Select snippet




[image: _images/usesnippet2.png]
Drop-down list of available code snippets appears. Select code snippet to insert.


	Placeholder appears




[image: _images/usesnippet3.png]
Code snippet placeholder appears in the position of caret.





          

      

      

    

  

    
      
          
            
  
Code snippets in help files

This is how a code snippet looks in CHM help file and WebHelp:

[image: _images/snipchm.png]
Code Snippet in a CHM

And in PDF/RTF/Printed Manuals:

[image: _images/snippdf.png]
Code Snippet in a PDF





          

      

      

    

  

    
      
          
            
  
Templates

Helpinator has template engine that uses layout templates for all supported formats when producing help files and documentation. Generally layout templates are divided into two groups:


	HTML-based templates for producing CHM help files, WebHelp, QtHelp, JavaHelp and EPUB/MOBI.


	RTF templates for producing RTF, PDF and printed manuals.




Helpinator comes with several predefined templates that you can use in your projects.

Templates are stored inside the project, so you need to add them first to allow Helpinator to use them.

[image: _images/projecttemplates.png]
Project templates

[image: _images/templatenodes.png]
Template nodes in the project tree view





          

      

      

    

  

    
      
          
            
  
HTML-based Templates

Each CHM/WebHelp template consists of two file groups:


	Required files. Usually templates’ main HTML page template and corresponding CSS file.


	Additional files. Images used by template, scripts and etc.




In predefined templates there’s jqueryui.zip file that contains JQuery UI theme for WebHelp (left pane with TOC, Index and Search). Inside it there’s jqueryui.css and jqueryui.js files and “images” folder with images used by this theme.

HTML templates use several tags, enclosed in {%%}:







	Tag

	Meaning





	TITLE

	Title of the current topic



	BREADCRUMBS

	Place for breadcrumbs links



	PREVNEXTTOPIC

	Links to previous and next topics, combined



	PREVTOPIC

	Link to previous topic



	NEXTTOPIC

	Link to next topic



	PREVTOPIC_INCL

	Link to previous topic, but instead of “Previous” text it uses HTML between this tag and END_PREVTOPIC_INCL tag.



	NEXTTOPIC_INCL

	Same as above but for next topic



	SEEALSO

	Lists related topics based on keywords match.






You can also use project variables inside templates.

[image: _images/htmltemplates.png]
HTML templates

[image: _images/htmltemplates1.png]
Inside an HTML template

Adapting WebHelp to your website

You can also adapt WebHelp appearance to the style of your website using WebHelp header and footer. This fields are not required, if empty WebHelp will fill entire browser page. When filled, header and footer will appear in separate frames.

[image: _images/htmltemplates2.png]
WebHelp Addons





          

      

      

    

  

    
      
          
            
  
PDF/RTF/Print Templates

PDF/RTF/Print templates are generally RTF files with several reserved pages:


	Cover page. Will be rendered without header and footer. Here you can place your logo and project title.


	Table of contents page. Has a number of lines, starting with LEVEL and followed by number indicating for which sublevel this line should be used. Top level topics are level 1 and so on.


	Topic template. Ususally has only TITLE and CONTENT tags, TITLE will be replaced by topic title and CONTENT with topic content.


	Glossary template. Has templates for the first letter, term and definition.


	Index page template. This page will list keywords and numbers of pages where they appear.




[image: _images/rtftemplates.png]
PDF/RTF templates

[image: _images/rtftemplates1.png]
Header, Footer and Cover page template

[image: _images/rtftemplates2.png]
Table of Contents
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Page Template





          

      

      

    

  

    
      
          
            
  
Tools

Helpinator has several built-in accompanying tools to make your help authoring process less frustrating. All of them are under “Tools” node of the project tree view.

[image: _images/tools.png]
Tools

Currently Helpinator has the following tools:


	Search and Replace. Allows you to find and replace text string in all topics of your project.


	Context IDs. Allows to edit all topic Context IDs in one place.


	Screenshots. Allows to take screenshots, apply effects and store them to the project’s image library.


	Global Spellcheck. Check spelling in all topics of your project.


	Image Tools. Group of tools for image processing.


	Check Links - to find broken internal and external links.


	REImport - if a topic was imported from a file, you can import it again if an external file was changed.


	WordPress Theme Builder - helps you to create a specialized software documentation theme for WordPress.


	GIF Screen Recorder - allows to record short animated GIFs instead of static screenshots.








          

      

      

    

  

    
      
          
            
  
Search and Replace

“Search and Replace” tool allows you to get a list of topics where certain phrase appears and optionally replace those occurrences.

[image: _images/searchreplace.png]
Search and Replace

To replace a text everywhere in your project:


	Check “Replace” option.


	Enter text to replace “text to find” with.


	Click “Go”








          

      

      

    

  

    
      
          
            
  
Context IDs

“Context IDs” tool allows you to review and edit Context IDs, used to connect help files topics with your application, in one list.

[image: _images/contextid.png]
Context Ids





          

      

      

    

  

    
      
          
            
  
Screenshots

“Screenshots” tool allows you to capture screenshots, store them to the project’s image library, create new topics and guides with captured images and more.

At the top of the window there are hotkey selector and start/stop button to start capture process.

Below is the settings tab set.

“General” tab allows you to select whether you want to capture new image and put it into specific category or recapture existing image.

[image: _images/screenshots.png]
Screenshot Tool

“Create topics and guides” tab allows you to create content elements when a new screenshot is captured.

You can:


	Create new topic containing captured image


	Append captured image to existing topic


	Create a new step-by-step guide. The new guide will be created on the first capture after you click “Start”. All captures after that will be appended to this guide.


	Append to Guide - newly captured images will be added as new steps to existing guide.




[image: _images/screenshots1.png]
Screenshot - create topics and guides

“Region and background” tab allows you to select what you want to capture.

You can:


	Capture active window only


	Capture entire desktop area


	Capture rectangular area around mouse cursor. In this mode you have to specify offsets in pixels from current mouse position that define rectangular area.


	Capture mouse cursor - allows to put current mouse cursor on the screenshot.


	Capture background - allows to capture rectangular area surrounding current capture rectangle. You can specify what part of the background to capture, effects to apply to it (you might want to darken or blur it) and make capture rectangle to “drop shadow” on background.




[image: _images/screenshots2.png]
Screenshots - capture region





          

      

      

    

  

    
      
          
            
  
Global Spellcheck

“Global Spellcheck” tool allows you to check and fix spelling in all topics. Though Helpinator has check-as-you-type spellcheck in the topic editor, you might want to check all topics for example after you imported some documents using file import/export feature.

[image: _images/spell.png]
Global Spellcheck





          

      

      

    

  

    
      
          
            
  
Image Tools

Image tools is a set of tools targeted at batch image transformation using project’s image library.

Currently it has only one tool - “Move Images To The Library”. It allows you to move all images from topics into the project’s image library thus allowing to edit, reuse and recapture them. This is useful when your project is partially a product of conversion/import.

[image: _images/imagetools.png]
Image Tools





          

      

      

    

  

    
      
          
            
  
Check Links

This tool allows you to find broken links in all topics of the project automatically. It shows a report grid with link details and a name of the topic where the broken link was found.

You can edit links right in the grid and then click “Fix links”. For each link you can select to:


	Replace broken link with a new URL


	Remove link


	Skip this item during next check.




[image: _images/checklinks.png]
Check Links





          

      

      

    

  

    
      
          
            
  
REImport

REImport tool allows you to import again external files that were changed since they were imported.

[image: _images/reimport.png]
REimport





          

      

      

    

  

    
      
          
            
  
WordPress Theme Builder

WordPress theme builder allows you to create a custom WordPress software documentation theme. The majority of WordPress themes do not suit software documentation well, Helpinator theme solves this problem. It makes your WordPress site look like a regular help file with tri-pane on the left featuring “Table Of Contents”, “Index” and “Search” and content area on the right.

[image: _images/wptheme1.png]
WordPress Theme Builder - Parameters

[image: _images/wptheme2.png]
WordPress Theme Builder - Colors and Fonts





          

      

      

    

  

    
      
          
            
  
GIF Screen Recorder

GIF Screen recorder allows to record short animated GIF files instead of static screenshots. You can select what area do you want to record - fixed rectangle around the mouse cursor or an active window and redefine a shortcut that starts and stops recording.

When you finish recording captured frames appear in the “Preview” area. If you are happy with it you can click “Create GIF” and store the file in the project’s Image Library.

Later you can use it in topics and step-by-step guides.

However, remember that animated files break single-sourcing, PDF and printed manuals allow only static images.

[image: _images/gifrec.png]
GIF Screen Recorder





          

      

      

    

  

    
      
          
            
  
Reports

Reports allow you to get summary information about your project and save/print it.

Currently Helpinator has the following predefined reports:


	Topic titles and IDs. Shows topic titles and corresponding Context IDs to reference specific topics from your app. Useful for communication between a tech writer and a developer.


	Empty topics. Shows all empty topics in the project. Good to make sure all topics in your project have at least some text.


	Tasks by topics. To manage tasks assigned to topics.


	Project stats. Shows different project stats like number of topics, words and etc.


	Topic structure. Prints topic tree.




[image: _images/reports.png]
Reports
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Reports - created report





          

      

      

    

  

    
      
          
            
  
ToDo List

Helpinator allows you to create and manage to-do lists - both for individual topics and the project as a whole. Using this little feature you are able to:


	Control your tech writers. Of course, this is not a full-featured project planner app with team features, but good enough for small teams and interacting with contractors.


	Keep your global to-do list free from small tasks associated with this project.


	Go to the place where a task should be accomplished, without wasting time on finding it.


	Never forget to to something on your project.




There are two places to work with tasks:


	“ToDo” tab at the bottom of the topic editor. This tab allows to add/manage tasks assigned to this topic.




[image: _images/eng-ed-todo.png]
Topic todos


	Global project to-do list with all tasks from all topics and the project itself.




[image: _images/globaltasks.png]
Global Tasks

To add a task for the project itself, not a topic, click “Add” in this global list.

There’s also a way to get printed version of your tasks list. Locate “Tasks by topics” report under “Reports” node and run it.

[image: _images/tasksbytopics.png]
“Tasks by Topics” report





          

      

      

    

  

    
      
          
            
  
Formats

Helpinator supports the following output formats:


	CHM (Compiled HTML Help)


	PDF


	RTF (with some limitations)


	WebHelp


	Printed manuals


	QtHelp (Qt Library native help file format)


	JavaHelp (Java native help file format)


	EPUB (e-books format)


	MOBI (Kindle e-books format).


	OracleHelp


	HelpGUI


	MajorMinHelp


	Publish to Wordpress CMS




CHM, WebHelp, QtHelp, JavaHelp, EPUB and MOBI are all HTML-based and rely on HTML-based templates. JavaHelp uses reduced set of HTML features therefore it needs specially formatted HTML templates. EPUB/MOBI are book-oriented and HTML templates for them also differ in formatting and structure.

OracleHelp is an advanced HTML-based help system developed by Oracle Inc. It is multilingual, and can be used as a local help file and WebHelp using the same compiled project.

HelpGUI is a lightweight Java-based help system for small apps.

MajorMindHelp is experimental multilingual HTML-based help system, at this time for Delphi only.

Wordpress is the most popular CMS right now, so if you run your project website on this help system you don’t need to mess with non-compatible webhelp systems, you can publish online documentation right to your CMS.

CHM is primarily Windows-based help file format, though there are some viewer implementations for other platforms too. WebHelp, QtHelp, JavaHelp, HelpGUI and OracleHelp are cross-platform formats.

PDF, RTF and printed manuals rely on RTF templates. PDF and Printed manuals are almost identical, except that Printed manuals are sent directly to printer and thus avoid image quality loss during compression. But PDF files have useful “Outline” with document structure and direct links to topics. RTF files are a limited version of PDF output, they do not have headers and footers.

[image: _images/formats.png]
Formats





          

      

      

    

  

    
      
          
            
  
CHM

Helpinator uses Microsoft HTML Help compiler to compile CHM help files. You need to install it prior to compiling CHM, otherwise Helpinator will report error. You can download it from Microsoft website or install htmlhelp.exe from the same zip archive with Helpinator setup.

Helpinator automatically generates “Previous/Next”, “Breadcrumbs” and “See also” lists.

If you have Glossary in your project - it will be compiled into CHM file as well.

To connect your CHM help file to your application you need to know Context IDs of topics. To get them in printed form you can run “Topic Titles and IDs” report under “Reports” node of the project tree view.

[image: _images/chm.png]
CHM - topic
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CHM - index
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CHM - Search





          

      

      

    

  

    
      
          
            
  
PDF/RTF

Helpinator generates PDF files with cover page, table of contents, glossary and index based on PDF/RTF template. TOC consists of hyperlinks, e.g. you can click on topic titles to go to corresponding topic. The same can be archived using navigation bookmarks tree on the left pane.

Pages have header and footer with page numbers.

[image: _images/pdf.png]
PDF - cover page

[image: _images/pdf1.png]
PDF - Table of Contents
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PDF  - topic
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PDF - index





          

      

      

    

  

    
      
          
            
  
Classic WebHelp

WebHelp is a set of javascript-powered HTML pages with table of contents, index and search feature. Helpinator uses the same HTML template to compile topic pages that it uses to compile CHM, except it publishes JQuery UI theme from jqueryui.zip file.

[image: _images/webhelp.png]
WebHelp - topic
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WebHelp - index
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WebHelp - search





          

      

      

    

  

    
      
          
            
  
Analytics and Social Integration

Helpinator allows you to add Google Analytics, AddThis and Disqus integration to WebHelp without altering HTML templates. All you need to do is to paste integration code provided by these services into corresponding project options.

[image: _images/webhelp4.png]
WebHelp analytics and social integration





          

      

      

    

  

    
      
          
            
  
Adapt to your website

Helpinator allows you to adapt WebHelp to your website design. There’s “WebHelp” tab in the CHM/WebHelp template editor with two groups: “Header” and “Footer”. There you can paste HTML code that will be shown above and below WebHelp panes.

Example can be seen in Helpinator’s own WebHelp:

http://www.helpinator.com/webhelp

[image: _images/webhelp3.png]
Adapt WebHelp to your site





          

      

      

    

  

    
      
          
            
  
How to Change Style of the Left Pane

WebHelp is based on JQueryUI so you can use it’s styles to change style of WebHelp template. Take a look at “Additional Files” section of default template. There you can see jqueryui.zip file. This file contains all required style data. The following steps show how to create your own:


	Go to  http://jqueryui.com/themeroller/


	Select colors that you like, then download corresponging zip archive


	Unzip it


	Create another folder were you will place working files


	Go to “CSS” folder unzipped from the archive.


	Copy images folder to your new folder


	Copy jquery-ui-*.css to the root of our new folder, rename it to jqueryui.css


	Go to “js” folder unzipped from the archive.


	Copy jquery-ui-*.js file to the root of our new folder, rename it jqueryui.js


	Zip our new folder (so jqueryui.css and jqueryui.js are in the root of the archive) and name it jqueryui.zip


	Place it into “default_files” folder or your own template folder, say “mytemplate_files” or remove default file from project template and add your own instead of it.


	Voila, you can compile WebHelp with your own color settings.








          

      

      

    

  

    
      
          
            
  
WebHelp 2

WebHelp 2 is a major overhaul of Classic WebHelp with the following aims:


	Avoid usage of frames that are obsolete in HTML by now.


	Make it responsive.


	Make it more SEO-friendly.




General structure of WebHelp2 matches that of Classic WebHelp, with “Table Of Contents”-“Index”-“Search” block on the left side, content block on the right plus customizable header and footer. But there are some differences as well:


	Step-by-step guides now use different engine that is modern and responsive.


	Code snippets highlighter is different too.


	Images scale automatically when window size changes.


	Web browser remembers last selected tab and width of the left sidebar.


	Folder structure is now more neat with “js” subfolder for JavaScript, all images in “images” folder and the main folder containing only html files.




Helpinator’s online documentation now uses new WebHelp 2:  http://www.helpinator.com/help/about.html

It looks like this:

[image: _images/webhelp2demo.png]
WebHelp2





          

      

      

    

  

    
      
          
            
  
Printed Manuals

Printed manuals act the same way and use the same template and settings as PDF format output, but instead of a file pages are sent directly to printer. When you click “Create printed manual” Helpinator shows you “Preview” dialog with pages that are about to be printed. You can navigate them, zoom in and out, and when you are satisfied - click on “Print” to print them.

[image: _images/print.png]
Printed Manual





          

      

      

    

  

    
      
          
            
  
QtHelp

**Qt **(from Wikipedia) -  is a cross-platform application framework that is widely used for developing application software with a graphical user interface (GUI) (in which cases Qt is classified as a widget toolkit), and also used for developing non-GUI programs such as command-line tools and consoles for servers.

You can read entire article here:

http://en.wikipedia.org/wiki/Qt_framework [http://en.wikipedia.org/wiki/Qt_%28framework%29]

Qt framework has it’s own help file format and framework called QtHelp aimed to provide native help files for applications written with Qt. You can read detailed description here:

http://doc.qt.digia.com/qt/qthelp-framework.html

Helpinator allows you to create QtHelp files with one mouse click. However you will need QtSDK to do it. Helpinator will create HTML files and all required QtHelp project files, then it will call help file compiler to create target help files.

To compile QtHelp you have to:


	Download and install QtSDK.


	Run Helpinator and select Main Menu->Tools->Options, then select “Compilers tab”


	Find QtSDK path line and enter path to BIN folder of QtSDK.




Note that to use Step-by-step Guides in your help files you will need QtSDK 4.8 and higher.

[image: _images/enoptionsqtcompiler.png]
Options - Compilers - Qt

Resulting documentation looks like this:

[image: _images/qthelp.png]
QtHelp - Contents
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QtHelp - Index
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QtHelp - Search





          

      

      

    

  

    
      
          
            
  
JavaHelp

JavaHelp (from Wikipedia) is both an application and a format for online help files that can be displayed by the JavaHelp browser.[1] It is written in Java, and is mainly used in Java applications. It can be used for any application and it does require the overhead of the JRE to load.

The file format is XML.

The GUI uses a tri-pane layout, with a toolbar and menu at the top, navigation pane on the left, and content viewer on the right. The navigation pane includes searching, indexing, and a table of contents.

Official website:

http://javahelp.java.net/

Helpinator allows you to create all required HTML and project files and automatically calls compiler that creates help file in JAR format.

To compile JavaHelp:


	Download and install JDK.


	Download and install JavaHelp SDK




http://download.java.net/javadesktop/javahelp/javahelp2_0_05.zip


	Run Helpinator, select Main Menu->Tools->Options and enter both paths to JDK and JavaHelp “bin” folders.




[image: _images/enoptionsjavahelpcompiler.png]
JavaHelp Compiler Options

Note that JavaHelp uses obsolete HTML viewer not capable of handling modern HTML features therefore it requires separate HTML template, default templates for CHM/WebHelp/QtHelp are not compatible with this output format.

Compiled JavaHelp file looks like this:

[image: _images/en-javahelp.png]
JavaHelp - Contents

[image: _images/en-javahelp1.png]
JavaHelp - Index
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JavaHelp - Search





          

      

      

    

  

    
      
          
            
  
EPUB

EPUB (from Wikipedia) (short for electronic publication; alternatively capitalized as ePub, ePUB, EPub, or epub, with “EPUB” preferred by the vendor) is a free and open e-book standard by the International Digital Publishing Forum (IDPF). Files have the extension .epub.

You can read more about this format:

http://en.wikipedia.org/wiki/EPUB

http://idpf.org/epub

Helpinator allows you to create EPUB books with one mouse click. All you have to do is:


	Select template for this format in project options.


	Install one of the available EPUB viewers to preview compiled ebook. For example you can use CoolReader:




http://www.coolreader.org/

HTML Templates for EPUB/MOBI formats are different from those used in CHM/WebHelp/QtHelp/JavaHelp. Though they too have <templatename.html> and <templatename.css> files, their logical structure is different:


	Default HTML file defines how a book page looks like.


	There are 2 additional HTML files: front.html and toc.html, the first for “front page” with title, author and etc and the second is for the table of contents.


	Default CSS file is for all 3 template HTML files.








          

      

      

    

  

    
      
          
            
  
MOBI

MOBI is a ebook format introduced by a company called Mobipocket. Now it is used in Amazon Kindle devices. Helpinator allows you to create MOBI ebooks with single mouse click.

To compile MOBI format ebooks you need KindleGen utility from Amazon:

http://www.amazon.com/gp/feature.html?ie=UTF8&docId=1000765211

To compile MOBI ebook:


	Donwload and install KindleGen


	Run Helpinator, select Main Menu->Tools->Options, “Compilers” tab and enter path to KindleGen utility.




[image: _images/enoptionskindlecompiler.png]
KindleGen

You might also need a MOBI viewer (Mobipocket Reader for example or  Kindle Previewer [http://www.amazon.com/gp/feature.html?ie=UTF8&docId=1000765261]).

Note that you can add a cover page image to your ebook (actually Amazon suggests you have one). Just put a file named syscoverpage.jpg into the project’s image library and Helpinator will use it as a cover page for your ebook.

[image: _images/en-kindle.png]
Kindle Book Preview





          

      

      

    

  

    
      
          
            
  
OracleHelp

OracleHelp is a help system, developed by Oracle Inc. You can read more about it here:

http://www.oracle.com/technetwork/topics/index-083946.html

It consists of two parts:


	OracleHelp for Java


	OracleHelp for Web




Both parts use the same help file format (except Web version requires one more file) and Helpinator generates files that can be used with any of them.

To compile OracleHelp:


	Download and install JDK


	Download and extract OracleHelp SDK




http://www.oracle.com/technetwork/developer-tools/help/utilsoft-ohw-422139.html


	Set Helpinator options




[image: _images/enoptionsoraclehelp.png]
Now you can compile OracleHelp by clicking “Compile OracleHelp” button on the main toolbar.

Compiled OracleHelp looks like this.

Table of contents:

[image: _images/oraclehelp-contents.png]
OracleHelp Table Of Contents

Topic view (undocked)

[image: _images/oraclehelp-topic.png]
QtHelp Topic Display





          

      

      

    

  

    
      
          
            
  
HelpGUI

HelpGUI is a lightweight help system for small Java applications. It has no keyword lookup or built-in search, but the best part is that it is small.

You can download it here:

http://helpgui.sourceforge.net/

To compile HelpGUI:


	Download and install JDK


	Set up Helpinator options for JDK just like in case of  JavaHelp




Compiled HelpGUI help file looks like this:
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MajorMindHelp

MajorMindHelp is our own help system for Windows applications. It is based on MajorMindHelpViewer - a viewer utility that is more than just a CHM-alike help system. You can read more about it in topic  MajorMindHelpViewer.

Main features:


	HTML-based, full-featured help system.


	Compiles right into Delphi application, no standalone files or help systems required


	No problems with CHM help files security


	No problems with WebHelp cross-browser compatibility and security settings.


	Multilingual. All languages are in one help file and they can be easily switched between.


	Transparent help file format - just a zip file with HTML and XML in it.




Helpinator compiles MajorMindHelp directly, without any other tools.

Compiled Help looks like this:

[image: _images/majormindhelp.png]




          

      

      

    

  

    
      
          
            
  
Wordpress CMS

Wordpress is the most popular CMS in the world. If your website is based on Wordpress and you need to organize online help for your product - you don’t need to create separate WebHelp section on your website aside from Wordpress. With Helpinator you can publish directly to Wordpress and turn topics into pages (not posts!). So you can use all Wordpress features in your online help!

There’s an in-depth tutorial on using Helpinator “Publush to WordPress” feature combined with Helpinator theme and Quick Publish plugin on Helpinator Blog:

https://www.helpinator.com/blog/2019/09/07/wordpress-for-online-documentation-how-to-use-helpinator-plugin-and-documentation-themes/

To publish your help file to Wordpress you need to set up your account information and select publishing options.

[image: _images/wordpress.png]
Publish to WordPress

Helpinator operates “profiles” to manage Wordpress sites. You can have several profiles and publish documentation to several blogs (test site and the main product site, for example). Click “+” to add new profile and select profile name.

Then you need to enter account info:


	Blog host address


	Blog “endpoint” (when xmlrpc.php file is in subfolder)


	Whether to use HTTPS for connections


	Username and password


	“Check connection” button allows to test connection requisites




Note that Helpinator does not store your password anywhere for security reasons. If you close Helpinator your password is lost.

Publishing settings:


	Page template - select one of PAGE templates available in your Wordpress theme. Click “Refresh” button next to it to get a list of templates.


	Parent Page - a page to assign root page of documentation to. Leave it blank to publish to the main menu. Click “Refresh” button next to it to get a list of pages.


	Root page order. By default your documentation root page will be attached to the end of parent page child pages list. You can change this value to insert it into another place.




Click “Save” to save your account info (without publishing) or “Publish” to publish it right away.

Don’t forget to save your project after you publish your documentation, otherwise you will NOT be able to republish it (e.g. overwrite altered topics).

Major Mind Software provides some useful WordPress plugins and themes for registered users of Helpinator:


	Helpinator QuickPublish plugin - this plugin extends WordPress API to allow to publish content faster and also fixes the problem of WordPress API that disrupts image republish feature blocking image rewrite.


	Helpinator WebHelp WordPress theme - documentation theme that resembles  WebHelp 2 in look and feel.


	Helpinator Modern Help WordPress theme - responsive theme for software documentation.




You can download plugins and themes here:  http://www.helpinator.com/download.html#wordpress





          

      

      

    

  

    
      
          
            
  
Knowledge Base

Knowledge base is a common documentation layout, without topic tree, or should we say, 2-level tree. There is no topic hierarchy, topics are grouped into “Categories”. The main page has links to all topics. It looks like this:

[image: _images/kbsample.png]
To generate a Knowledge Base from an existing project you need to add “kbdefault” template to the project first.





          

      

      

    

  

    
      
          
            
  
Understanding Profiles

“Knowledge Base” generator settings are organised into “profiles”. Profile allows you to set unique KB structure that may not match structure of your project.

Helpinator project is based around topic tree with unlimited levels, KB structure has 2 layers max: Categories and Articles. Helpinator allows 2 modes for structure transformation:


	Automatic mode. In this case all first level topics become categories (their content will not appear in the KB), all lower level topics are combined into a plain list under that category.


	Manual mode. Allows to define categories then selectively add topics to them and rearrange.




“Structure” tab of profile settings allow to select the mode and do manual operations.

[image: _images/kb1.png]
Knowledge base has a sidebar with lists of “Popular” and “Recently updated” articles. To fill these lists you can use Auto/Manual modes too. Auto mode is equivalent to random in this case.

[image: _images/kb2.png]
[image: _images/kb2-2.png]
[image: _images/kb3.png]
[image: _images/kb3-2.png]
You can also define your KB title and tagline or use project title as KB title.

[image: _images/kb4.png]




          

      

      

    

  

    
      
          
            
  
GitHub-flavored Markdown

Markdown is a plain-text format for writing rich formatted documents. Of course you can create Markdown files in any text editor but when it comes to handling large projects with images, tables, glossaries and how-to’s, you definitely need a helper tool. Helpinator brings the power of a conventional help authoring tool to the world of Markdown!

GitHub-flavored markdown is a superset of regular markdown tailored to be used to document GitHub projects. Basically there are 3 ways you can use Markdown on GitHub:


	To create a readme.md file in your project root folder. This text GitHub shows when a user visits project page on GitHub.


	To create a large project Wiki (“Wiki” tab of the project)


	To create GitHub Pages - a static project website platform that you can link your own domain to. It is a kind of free website hosting limited to static sites.




All 3 are Markdown files, but in the first case Helpinator will create a single markdown file from your project with project title and table of contents. In cases 2 and 3 Helpinator will create one markdown file per project topic, the difference is in file naming and TOC linking. Besides that Wiki mode allows to create a sidebar with table of contents for navigation. In all 3 cases images will be published into the “images” folder next to your markdown files, do not forget to commit this folder using git!

Click “Github-flavored Markdown” icon on the main toolbar, “Export GitHub Markdown” dialog appears.

[image: _images/githubflavoredmarkdown3.PNG]
To generate README.MD file from your project select the first option “Create readme.md”. Here you can change file name of the output file and tell Helpinator that you want a project title and a table of contents included. If your project is small you can choose not to add the table of contents. Click OK and the file gets generated in the “gitmarkdown” sub folder in the folder where your project is stored.

[image: _images/githubflavoredmarkdown.PNG]
To prepare source files for project Wiki select the second option. You can choose to add optional sidebar with table of contents for navigation. Helpinator also creates required “Home.md” file that GitHub Wiki uses as a home page and places project title and table of contents in it. Click “OK” and commit generated files with “images” sub folder into the Wiki repository (it’s name matches your project repository with “.wiki” postfix added to it).

[image: _images/githubflavoredmarkdown1.PNG]
To create source files for GitHub Pages select the 3rd option. Helpinator creates one markdown file per topic plus “index.md” file with table of contents. You’ll need to commit them to the root folder or “docs” sub folder of your repository and set up GitHub pages on the Settings tab of your repository.

[image: _images/githubflavoredmarkdown2.PNG]




          

      

      

    

  

    
      
          
            
  
SimpleDocServer

SimpleDocServer is a simple markdown-based web server for light in-house company documentation. It is very easy to install, has almost zero administration and maintenance costs. You can read more about this product here:  http://www.helpinator.com/simpledocserver.html Though you can easily author SimpleDocServer content in any text editor since it uses markdown, Helpinator allows to author content more conveniently. Also it allows you to create context ids for topics so you will be able to use your SimpleDocServer content as a source of context-sensitive help via  MajorMindHelpViewer.





          

      

      

    

  

    
      
          
            
  
LiteHelp

LiteHelp is a lightweight help system created by Major Mind Software as a simple alternative to MajorMindHelp, WebHelp and other highly customizable help systems based on HTML.

It is based on XML, has a limited set of formatting options but has a rich set of embeddable objects supported by Helpinator:


	Figures


	Step-by-step guides


	Code Snippets


	Videos


	FAQs


	Quizzes




LiteHelp format is basically a set of XML files, so there’s no vendor lock-in and there are no security risks associated with HTML.

LiteHelpViewer is a viewer app for LiteHelp help system. It is a classic viewer with “Contents”, “Index” and “Search” tabs. The executable is portable and self-contained, you can distribute it with your application if your LiteHelp help system was generated with Helpinator.

You can read more about LiteHelp here:  http://www.helpinator.com/litehelp.html





          

      

      

    

  

    
      
          
            
  
LeanPub

LeanPub [https://www.leanpub.com] is a well-designed and feature-rich platform for publishing ebook and paperback books combined with a digital storefront to sell your books.

It allows to author your books in plain text, using LeanPub-flavored markdown. Helpinator allows to generate markdown source project for your LeanPub book from your project.

You can then upload generated content to DropBox or GitHub and allow LeanPub to consume it.

To generate LeanPub source project (manuscript) you can do the following:

Select “Compile LeanPub book” from the “Tools” menu.

[image: _images/toolscompileleanpub.PNG]
Tools - Compile LeanPub

or create a batch with this command:

[image: _images/leanpubbatchcompile.PNG]
LeanPub batch compile

There’s a post on our blog that covers in detail the whole process of publishing your project on LeanPub:  https://www.helpinator.com/blog/2019/08/23/leanpub-tutorial-publishing-your-book-using-helpinator/





          

      

      

    

  

    
      
          
            
  
Advanced Topics

The following topics are for advanced users of Helpinator.





          

      

      

    

  

    
      
          
            
  
Conditional compilation

Conditional compilation allows you to modify Helpinator output based on values of user-defined variables.

It may be used in both of two ways:


	To skip portions of text


	To skip one or more topics entirely.




To skip/include portions of text Helpinator has built-in IF directive which has the following syntax:

[image: _images/eng-cond-text.png]
Conditional Compilation

In the first case IF clause allows to skip the text inside it when “EDITION” variable has “PRO” value.

In the second case the text will be skipped without any conditions. This makes COMMENT tag a good way for text reviews.

To skip a topic from output completely (e.g. even from TOC) there’s “Skip topic” tab in the topic editor

[image: _images/eng-ed-skip.png]
Skip the topic

In the case above Helpinator will skip the topic entirely when EDITION is NOT equal to ‘PRO’.

Other options include:


	Skip topic from certain formats - for example a topic contains video samples and you might not want it in PDF format (since it will be empty) so select “Skip from formats” and check “PDF”


	Skip always - always skip this topic, for example if it’s not ready yet.








          

      

      

    

  

    
      
          
            
  
Command line tool

Helpinator comes with command-line compiler chelpinator.exe that you can use in batch files (.bat, .cmd).

It has the following parameters:

chelpinator.exe <projectfile> <batchname>

<projectfile> (required) - full path to the Helpinator project you are about to compile.

<batchname> (required) - name of the batch saved to the project file.

Example.

Suppose path to your project is C:ProjectHelpmyproject.hpz.

You need to compile PDF help from it and place it into C:PDF folder. You have variable preset “pro” and want to use it. You have several languages in the project and you want to use “English (United States)”

You need to do the following:


	Click on the lightning bolt icon on the main toolbar


	Click “New batch”


	Double-click PDF output on the left to add it to the batch


	Set output path to “C:PDF”


	Save the batch with a meaningful name like “mypdf”.


	Save proejct file.




Now you can call command line compiler to produce PDF:

chelpinator.exe “C:ProjectHelpmyproject.hpz” “mypdf”





          

      

      

    

  

    
      
          
            
  
Organizing text reviews

Helpinator allows you to organize text reviews by team members not involved in authoring process. For example, you have a dedicated tech writer and a group of developers and experts who are concentrated on development and communicate with a tech writer only occasionally. You need to organize help project reviews, say, once a month, when other team members can read documentation and leave their comments. The problem is how to connect comments and topic content without affecting it.

With Helpinator you have two ways to do it:


	“Notes” tab in the topic editor allows you to write any topic-related text there.


	“COMMENT” ` conditional compilation <#t807CF7472FA741D783D86FC323F142FA>`_ tag allows you to skip part of the topic from compilation. Hence, you can write comments inside COMMENT tags right in the place where they should be.








          

      

      

    

  

    
      
          
            
  
Batch Compile

Clicking on toolbar icons to get output is time-consuming when you need multiple formats at once. That’s why Helpinator allows you to create “batches” that consist of several “tasks”. Each task allows to compile selected output format with pre-selected language and variable preset and then save it to the specified location.

You can save batches to external xml files or into the project itself. In the latter case you can access them with a drop-down on the main tool bar.

[image: _images/batchcompile1.PNG]
Batch Compile ont the main Toolbar

When you click the drop-down arrow a list of batches saved to the project appears. You can click on a batch in the list to run it instantly.

[image: _images/batchcompile3.PNG]
On-click execution of saved batches

Click “Manage internal batches” to edit the list of batches saved to the project.

[image: _images/batchcompile4.PNG]
Manage internal batches

When you click “Batch Compile” icon with a lightning bolt “Batch Compile” dialog appears. It allows to create a batch by adding output tasks to it (double click on desirable output format in the list on the left), set output destination path, language and variable preset.

[image: _images/batchcompile.PNG]
Batch Compile





          

      

      

    

  

    
      
          
            
  
MajorMindHelpViewer

MajorMindHelpViewer is a standalone context-sensitive help system viewer designed for use with help outputs generated in Helpinator. It has the following modes:


	MajorMindHelp - in this mode the viewer shows MajorMindHelp help system generated in Helpinator. You can choose to show a local version or the one stored on an HTTP(S) server.


	SimpleDocServer - in this mode you can specify an address of a SimpleDocServer server and show it’s content as a context-sensitive help.


	Free-form HTML mode - allows to show any HTML-based output of Helpinator as a context-sensitive help for your application. For example, you can make a context-sensitive help system out of topics published to Wordpress.








          

      

      

    

  

    
      
          
            
  
Localizing help files

Helpinator allows you to create multi-lingual help projects. You can store all languages in one project file, preserving project structure and topic context IDs across all supported languages. Thus you don’t need to manage separate help projects for all UI languages supported.

Helpinator localization capabilities stand on three whales:


	Multiple languages in one project file


	Language strings that allow to translate templates


	XML Import/Export that allows to communicate with translation services and software.








          

      

      

    

  

    
      
          
            
  
Multiple languages

Additional languages in your project affect:


	Topic titles and content


	Project and topic keywords


	Glossary


	Text snippets




Important notice!

To compile CHM help files with locale different from your default system locale you might need SbAppLocale.exe tool. Microsoft CHM compiler is not always capable of compiling correct CHM files with other locales, for example it will fail to compile Cyrillic locales on US versions of Windows.

The tool can be found here:

http://www.steelbytes.com/?mid=45

Download it and put into Helpinator installation folder.

To add languages to your project you can either use “Add languages” button in the “New Project” dialog or “+” sign on the main tool bar next to the language drop-down list.

[image: _images/multiplelanguages.PNG]
Add Languages





          

      

      

    

  

    
      
          
            
  
Language strings

Language strings allow you to translate common strings used in templates (like “Table of Contents” for example) into desired language. To do it call “Main Menu->Tools->Options” and select “Language Strings” tab.

[image: _images/lang.png]
Language Strings





          

      

      

    

  

    
      
          
            
  
XML Import/Export

XML Import/Export allows you to communicate with translation services and software. In general the procedure is as follows:


	Say you have a one-language project with “English” default language.


	Add new language, for example “German” and check to copy default language to it.


	Export XML using “Main Menu->File->Export XML”. Select “German” language and folder to export files to.


	Helpinator will create a set of XML files with topics, keywords and glossary terms.


	Send this files to your translation service or translate it with translation software.


	Import translated XML back using “Main Menu->File->Import XML”. Select “German” as destination language and a folder where XML files are located.








          

      

      

    

  

    
      
          
            
  
Quizzes

Quizzes in Helpinator are an easy way for your customers to check themselves for what they have learned from your documentation. They are not intended to be used as a teacher control measure.

You can have as many Quizzes as you wish and embed them anywhere in the project, may it be the final topic of the entire doc or chapter ends.

Each quiz question has:


	Question text. You can format it as a regular topic, embed images, etc.


	Answers. You can select answers numbering mode (letters or numbers), specify answers if they are not given in the question text itself and mark correct answers (there may by more than one).




In case of HTML-based documentation quizzes are interactive and are shown as a form for user to fill. When the user is ready he can click “Check answers” button and internal script will show a message with results (OK or not OK). If not OK, the user should figure out what is wrong, there will be no clues.

In case of printable docs and HTML docs without scripts, quizzes are not interactive, showing only circles (for single-choice answers) and boxes (in case of multipel choice answers) for a user to check with a pen.

You can check the sample quiz or look through a step-by-step guide on how to create and embed quizzes.





          

      

      

    

  

    
      
          
            
  
Quizzes Editor Overview

To activate Quiz Editor first select “Quizzes”  node in the project tree view. If it is not visible, then click “Quizzes” button on the project tree filter toolbar:

[image: _images/quizfilter.png]
Filter Quizzes in the tree

[image: _images/quizzesnode.png]
Quizzes node

List of Quizzes looks like this:

[image: _images/quizlist.png]
Quiz list

Double click a quiz in the list and the Quiz Editor appears:

[image: _images/quizeditor1.png]
Quiz Question Editor

[image: _images/quizeditor2.png]
Quiz Answers Editor





          

      

      

    

  

    
      
          
            
  
How to Embed a Quiz

You need to use QUIZ pseudo tag to embed a quiz into a topic and QUIZANSWERS tag for correct quiz answers (usually at the end of the printable doc). Of course you can place correct answers in HTML-based documentation as well, but it ruins experience for your users.

Optionally you can use editor drop down list to select a QUIZ and insert the tag in the place of caret.

[image: _images/embedquiz.png]
Insert a quiz into a topic

[image: _images/ebedquizanswers.png]
Embed Quiz Answers into a topic





          

      

      

    

  

    
      
          
            
  
Sample Quiz

What is Helpinator?

Do you know now what is Helpinator?

¡ 1 Screenshot tool

¡ 2 Text Editor

¡ 3 Help Authoring Tool

Who is Helpinator for?

Check one or more answers.

¨ 1 Doctors

¨ 2 Novel Writers

¨ 3 Technical Writers

¨ 4 Software Developers





          

      

      

    

  

    
      
          
            
  
FAQ Lists

Helpinator allows you to create and embed Frequently Asked Questions (FAQ) lists. Of course you can create FAQs with a regular topic editor, but it is not fully convenient and large FAQs are hard to manage this way. Helpinator has a specialised editor for FAQs and also renders FAQs as collapsible sections in case of HTML-compatible formats. See  sample FAQ page for example or check out a  step-by-step guide on how to create FAQs using Helpinator.

You can add as many FAQ lists into your project as you wish. You may find it useful when you need to add FAQs at the end of each large chapter of documentation.

Each FAQ contains of sections that help to organize questions in it. Questions belong to sections. Answer text is like a regular topic, you can embed images, step-by-step guides or code snippets into FAQ answers.





          

      

      

    

  

    
      
          
            
  
FAQ Editor Overview

To open up FAQ editor first select the FAQ node in the project tree view. If there is no “FAQ” node check out the FAQs are not filtered out from project view, corresponding button on the leftmost toolbar should be checked.

[image: _images/filtertoolbar.png]
FAQ filter button

[image: _images/faqsnode.png]
FAQs node

List of FAQs looks like this:

[image: _images/faqlist.png]
List of FAQs

Double click a FAQ and FAQ editor appears:

[image: _images/faqeditor.png]
FAQ Editor

[image: _images/faqeditor2.png]
Edit Questions





          

      

      

    

  

    
      
          
            
  
How to Embed a FAQ

To embed a FAQ into a topic you need to use FAQ pseudo tag. You can enter it manually or place cursor into a desired position and select a FAQ from toolbar drop down list of the topic editor.

[image: _images/embedFAQ.png]
How to embed a FAQ





          

      

      

    

  

    
      
          
            
  
Sample FAQ

About Helpinator

Q: Why the program is called Helpinator?

Good question! It was named in a homage to author’s great-uncle who coincidentally was named Helpinator. Just kidding. For no reason actually, other that awesomeness.





          

      

      

    

  

    
      
          
            
  
Quiz Answers

Answers for “Helpinator Concepts” quiz

1: 3

2: 3, 4
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Glossary

**CHM: **Microsoft Compiled HTML Help is a .. _http://en.wikipedia.org/wiki/Microsoft:Microsoft proprietary .. _http://en.wikipedia.org/wiki/Online_help:online help format. It was introduced as the successor to .. _http://en.wikipedia.org/wiki/Microsoft_WinHelp:Microsoft WinHelp with the release of .. _http://en.wikipedia.org/wiki/Windows_98:Windows 98 and is still supported in .. _http://en.wikipedia.org/wiki/Windows_7:Windows 7.

**HTML: **HyperText Markup Language (HTML) is the main markup language for web pages. HTML elements are the basic building-blocks of webpages.

HTML is written in the form of HTML elements consisting of tags enclosed in angle brackets (like <html>), within the web page content. HTML tags most commonly come in pairs like <h1> and </h1>, although some tags, known as empty elements, are unpaired, for example <img>. The first tag in a pair is the start tag, the second tag is the end tag (they are also called opening tags and closing tags). In between these tags web designers can add text, tags, comments and other types of text-based content.

**jQuery: **jQuery is a cross-browser JavaScript library designed to simplify the client-side scripting of HTML.[1] It was released in January 2006 at BarCamp NYC by John Resig. Used by over 55% of the 10,000 most visited websites, jQuery is the most popular JavaScript library in use today.[2][3]

**PDF: **Portable Document Format (PDF) is a file format used to represent documents in a manner independent of application software, hardware, and operating systems.[2] Each PDF file encapsulates a complete description of a fixed-layout flat document, including the text, fonts, graphics, and other information needed to display it. In 1991, Adobe Systems co-founder John Warnock outlined a system called “Camelot”[3] that evolved into PDF.

**RTF: **The Rich Text Format (often abbreviated RTF) is a proprietary[6][7][8] document file format with published specification developed by Microsoft Corporation since 1987 for Microsoft products and for cross-platform document interchange.[citation needed]

Most word processors are able to read and write some versions of RTF.[9] There are several different revisions of RTF specification and portability of files will depend on what version of RTF is being used.[7][10] RTF specifications are changed and published with major Microsoft Word and Office versions.

**WebHelp: **Web help is a type of online help that can either be delivered through the internet or as a stand-alone set of HTML files on a computer. A well-known example of such a system is WebHelp.Com[1]. This approach, mixing internet and local resources, is also used in Windows XP’s Help and Support feature.





          

      

      

    

  _images/createepub1.png
Name
[ eetaitiim
-
rahelp-defauit. html





_images/newproject1.png
General [ Topics and Keywords | images [ Templates|

SaveTo:

© Singfie, zp-compatble (“hp)
CiProjectieb stepbystep.hpz

© Ves-compatbie, folder






_images/newproject0.png
File Tools Help

Helpinator s a help authoring tool for small tea

Benefits

| Lorem |





_images/createepub3.png
T TETHIEEE AnaligHanE spEeres Getaut

PDF Template (Language Specific default.
Print Template (Language Specific) default.
Qttielp Template (Language Specific) defaut.

Javatielp Template (Language Speciic) avahel

EPUB Tempiate (Language Spedfic) epubmo
MOSI Template (Language Specific) epubmo

default,
[avahel

HelpGUI Template (Language Spedf) avahel






_images/newproject3.png
General [ Topics and Keywords | Images | Templates|

[Ex\Samplesimg StepBySteplgeneral.png
/Ex\Samplesimg StepBySteptopics.png






_images/createepub2.png
& NolName.html

© Buitn:






_images/newproject2.png
General | Topics and Keywords | images | Templates|

Topics one topic per ine, identify levels with TAB):

About

Support

Order

Gettng Started
"Main Menu
Toobar

Tutorial
Task 1
Task2

Keywords (one per ine):

project
image.
task






_images/createepubkindle.png
Hﬂ\@\!@\\@\@z'

e






_images/oraclehelp-contents.png
[= ][O

[B Ul oveniew
[ Project Structure:






_images/createepub4.png
T
oEes v e -






_images/newproject4.png
Genesal TopcsandKeywords | images | Tempates
Format ©sun:

Errerr il

) or (agobe Aabat) -

(e arosoft wera)

© e ] &
| - e

[0 aser

& smaren

i

Lorem ipsum dolor sit amet, cum ea labitur docendi qualisque. e nis!
unum mazim cu usu. Facer essent referrentur usu . his no saperet al
definitiones. Quo cibo sonet dolorum ea, eu quod erroribus explicari se|

Omittam recteque intellegat has ad, mlls ullamcorper et quo. Sit cu ¢
‘per malis zril. Cum inani nihil appareat ea. Duo ne fabulas meliore acct
us. Ea nec veri idens postea, pro et consul appareat, quaeque patrioc _
D)






_images/createfaq10.png
T Normal text + 17 eaion

R e

(4FAQ maine)






_images/pdf.png
2 hlpinator.paf - Foit Reader

HE 2 s
Socknars .
B | IS

Helpinator
11 About

T Benefits

1 Tutoral

1 support

I order

) How to...

1) Getting Starte
1 project

1T Topics and Cor|
T} Styles

[ Manage Glossa|
1) 1mages

1) How to Work |
1) stepby-sten 6
) Text Snppets
1) Code Snippets
11 Templtes

1 Tools

5 Reports

) Tobo Lt

B fomats |
1) Advanced Topi
) Localeng help

11 Quizzes
w5 FAO Licte
Cim i

i

Holpinator
Version 315

User Manual
Conpie 201 i S






_images/createfaq1.png
Quizzes.
4] HTMLbased Templates
defauithim

epubmobi-defauit html
javahelp-defauit html
Notame.hnl
4 POFRTF Print Tempiates.
) defouterts
Tasks






_images/oraclehelp-topic.png
Help Topic Window

Getting Started > Start a new project

There are two ways to start a new project
1. Start new, blank project
2. Import existing documentation

This step-by-step guide shows how to start a new project in Helpinator:

1. Adjust General Settings






_images/createfaq3.png
New FAQ
Ertername.






_images/pdf2.png
GHEe @

El

(S

119 capture scr
I Recapture ¢
/T Add annota
11 Quickly upd
1) Create step|
1) Create CHi
1) Create POF
/T Create Wet|
1) Create QtH
1) Create Javal_
19 Create EPU
[T Embed Vide
/13 change ord|
1) Create a FA
1) Create a Q
-1 Getting Starte

Ne # © @

ULOverviev

@1 Project
1) Topics and Cor.
@19 styes
{E Manage Glossar
e-[I Images
T How o work \
3

T impor ensi |

F——






_images/createfaq2.png





_images/pdf1.png
Step-by-step G
Text Snippets
Code Snippets






_images/createepub.png
reatechm
eateguide

S Vo
] Aboutieinator
4 [5] HTMLbased Templates

4R Tooks
5 search &Replace
o ContextDs






_images/createchm9.png
Topics
About

Senefis
Tutoral
Support
order
D ronto
Starta new proect
Import existng documentation

Capture saeenshots Helpi
REcapture screenshots and
Add annotations to sreenshots creat:
Quickly update screenshots when UI chs Helpi





_images/newclonedimage.png
File Tools Help

"]=1V4

0=+ 020AEIDEE S GO s

(5} mage Library
+B—\IHJ@\?\E\D%H

2R Tods.
£ Search &Replace
8 ContextDs
o) Sareenshots
Globalspelicheck
Imoge Tools
CheckLinks
2 remport
Y WordPres Theme Buider
LGk GF SqeenRecorder 7]

e »

(=]
0 =l
o=
o=
o=
o=
o=
o=
o=
o=
(=]
0@
0=
o=
o=
(=]
0@
0=
o=
o=
o=
o=
(=]
(=]
0=
o=






_images/kb4.png
JEBE3@

[Cluse project ttle

Tite:  Helpnator k8

Tagine: Sample Helpinator Knowledge Base






_images/codesnippetmanager.png
File Tools Help

enreatencbhely
enembedvideo

en-formats.
eng-code-snippets

] codesrippet.pog

] codesnippetmanager.pg
{E] Helpiator.png

] sripchm.png

Tools & Reports.

“ 7 Reports
] Topic Ttes and 0.

] Emoty Topis:

(] Tasisby topes

] rojectsats
{0 Topic structre

<[






_images/lang.png
Options.

General

Language stings

Lonsuss: (g UnkedSies

Key

NEXTTOPIC
PREVTOPIC
PREVNEXTTOPIC
SEEALSO
CONTENTS

INDEX.

SEARCH
GLOSSARY

INDEX.
00

Value
Newt
Previous
FreviousNest
Seedso
Conterts
Indes

Search
Glassary
Indes

Table of Conterts






_images/codesnippet.png
 File Tools Help

uwg7

Q o

+H rebreor
4 Code Sippets
1] helpinator. il
> @ nages
o i vieo

Engish (United Stat

Tools & Reports

+ T resars
s ——
] Enoty Topis
] sk by topics
O proctststs
] Topcstrctre

ey1e>
—ourstep {
width: 890px;

neignt: 250p:
i

~touring
wideh: 50%;
float: left;
margin-top: 10px;

i

-touring img {

190px;
border: Spx solid $402040;

-tourtext {
wideh: 50%;

. Take a tou

help autho:






_images/kbsample.png
Helpinator KB

Sample Helpinator Knowledge Bas:

Popular Articles
B Add annotations to screenshots
B Start a new project
B Create step-by-step guides
B Import existing documentation
B REcapture screenshots

B Quickly update screenshots when Ul

changes

How to...

B Start a new project

B Import existing documentation

B Capture screenshots

B REcapture screenshots

B Add annotations to screenshots

B Quickly update screenshots when Ul
changes

B Create step-by-step guides

Images

Blimages
B Managing Images
B Image Editor

B Using Images

B Cloned Images





_images/createchm10.png
HIM_ based Tenplates
defaul il
epubmabi-defauit
javahelp-defauit.html
Nobame.himl

4 ) POFRTF print Templates:

@) defauit.rtf
4R Tooks

D Search &Replace
8 ContextmDs






_images/manageguides.png
File Tools Help
ugs- E
Q

Engish (United Stat

YEoAROEES ® e

Step-by-step Guides

/
] aeatecm.prg =
] eatechmi.png

{E] reatechm2.png

capturescreenshots
estechm

esteepud

restefag

areateguide

reatepdf.

aeateqthelp

reatequiz

restenebhelp

embedvideo l
importexistingdocs [
newproject

0000000000000

o {0 Reports B
] Topic Tites and s
] Empty Topics:
] Tasks by topis
[ project stats
1] opic structre






_images/contextid.png
File Tools Help

uwg7 0s>VEe0ANOREEY © O =-

Q 8 Tools | Context IDs

[Topic/anchor Context D 2

(Create PDF and printed manudls

(reate webreh

[ Tools & Reports (reste Qi

(Create JavaHelp and OradeHelp

4R Tools (Create EPUB and MOBI ebooks B

£ searcha Enbed Video from YouTube, Vineo and et 1020
(Change order and herarchy of topis quickly 1090

reate aFaQ 1130

reate a Qui

fmage Tools (Getting started n

1 Cpeckinks | |uroverview &

&) Retmport Project Structure £

A WordPress Theme Buider Output Formats. %0
G GIF Screen Recorder o 20

4T Reports hd 2






_images/majormindhelp.png
(? About -

Helpinator is a help authoring tool for teams and
individuals who document their software project
themselves. Its relatively inexpensive and not as
bloated as big tech writing packages.

Helpinator is a single source tool. You can compile
CHM. PDF. RTF, DOCX, WebHelp (Classic and New
WebHelp2), Mol itHub-flavored Markdown.
Printed Manuals. EPUB and MOBI ebooks, JavaHelp,
OracleHelp, HelpGUI l from single source. You can
even create software documentation WordPress
themes and publish your online documentation to
WordPress!

Helpinator is a WYSIWYG tool. Write content in friendly
environment

Helpinator is multiingual. You can have as many project
languages as you wish. Work with any translation
service you wish using XML Import/Export "

Check the complete list of benefits on our website:






_images/createchm6.png
Name.






_images/managetopics.png
File Tools Help

encreatespud
encreatepdf

enreateat
en-emby

en-form|

engcor

eng-editor
eng-do
eng-text-snippets
enguides

enimages

4R Tooks -

5 search &Replace

,

Ol SRANI )

Englsh (United States)

D\EDDDD

& Context s

@ Screenshots
Global Spelcheck.

- 000000000000000000

1

(] L & Topics:
- about

- Benctits

- Tutorial

f-support

- order

2 How to

Startanew project
Import existing documentation

Create PDF and printed manuals
Create Webtielp

Create Qtrelp

Create Javabielp and Oradietielp

Create EPUB and MOBI ebooks.

Embed Video from YouTube, Vimeo and etc
Change order and hierarchy of topics quickly.
CreateaFaAQ

Create a Quiz

- Getting Started

Context D

g3gg3gesens°

%0
00
10
o2
E

50

1020
1090
1130
1%

D

about
benefits
tutorial
support
order

honto
startanenpr.
importexistn,
capturescree.
recapturesar.
addanotatio.
quickyupdat.
reatestepby.
areatechmhel,
createpdfan.

areatenebhelp

createqthely
aeatejavahe.
createspuba,
embedvidef.
howtochang.
aeateafag
createaquiz
gettngstarted

’

£5 image Tooks 2






_images/createchm5.png
File Edit View Favorites Tools Help

= v oo X i

Add Bdract Test Copy Move Delete Info

2 | B eFiretox Downloadsinelpinstor3professionalaip

‘

Name Sie  PackedSize
WiHspinatoprofessionaio 2o R%9NT
Wihtmihelp.ex 3507384 3507384
[lreadmeat s63 s63

B3 Z

0 object(s) slected






_images/managetextsnip.png
File Tools Help

How to Embed a Quiz
Sampe Quiz
+{{JFaqusts

@ FAQEdior Overview

How to Enbed aFAQ
Somple FAQ
[ Quiz answers:
P Kepuords
= Gossary
412 TextSnppets |

{E] batchcompile3.PNG

R P — v

oAaApQEEs W e

Engish (United Stat

+ T resars
s ——
] Enoty Topis
] sk by topics
O proctststs
] Topcstrctre

i)

Name

[rseome ]






_images/createchm8.png
egistered to DmitiPopo)
S0ARMAEE 2O

“ | [ project options

General | Tempiates | Variables | webrielp | New Templates

CHM (Language Specific)
Webrelp Template (Language Specific)

Gefauithim

RTF Template:

POF Template:

Print Template ((anguage Spec

Qttiep Template (Language Specific)

Gefauithim





_images/newblankimage.png
NewImage

File Name:
sample.prg

widh 250

Heiht: 250

FilCdor gy






_images/createchm7.png
~ip-default.html
e html

© Builtn:

e

For: CHM, HTML, QTHELP.

© From Filey






_images/namesteps.png
Add Images:
addText
Create Topic
(Guide Name
Guide Options.

e Sz






_images/cloneexampleclone2.png
(5} mage Library
+r—-bbiE|c( @ E@e
Name

) [ - advanced
batchcompie NG

0000000 00003000
B (1] 7 ) [ 5 [





_images/kb3.png
JEBE3@
Stucur | Popiar | Recent

Tite.

7] Generate automaticaly (based on topic change dat)

+—00






_images/cloneexampleclone1.png
o

X Tools & Reports.






_images/kb3-2.png
KnowledgeBaseSettngs
JEBE3@
rofie: [pafaut

Structure [ Popular | Recent [Tite

(Generate automaticaly (based on topic change date)






_images/cloneexampledonor.png
O0=s55020ARAIRES GO =

(& Image Library
+r—-bbiE|c( @ E@e

Name

I~ batchcompie LPNG
[~ batchcompie2.PNG

[~ batchcompie3.PNG

[~ batchcompie4.PNG

I~ ediytorkeynords.PNG
I~ eng-cond-text.png

- keywordseditor2.PNG
- keywordseditor3. NG
" pastefromipboard NG
£ en-capturescresnshots.

- capturescreenshots.png
- capturescreenshotso.png
- capturescreenshots1.png
L capturescreenshots2.png
£ enreatechm

- createchm10.png

- createchms.png

- createchmé.ong

- createchmz.ong

- createchms.ong

L reatechms.png

o enreatespud

|- createepub.png

[ reateepubL.png -

TR ook =
D search aReplace
8 Context s
<) Saeenshots
Gobal Speleheck
Image Took.
CheckLinks
£ remport
AV WordPres Theme suider
B GIF screen Recorder -

O00000000000000000000000000
Jufia==ial i ol ==iaofua o= af ayia ofial el afia afiaf






_images/createquiz2.png





_images/quizeditor2.png
Ques

+-2600

Question Tite

@ hatisHeprator?
@ vinossHeonator for?

Number of options:

Correct:

© Options with text (one per fne)

e el

©3

[Co..._Opton

Screenshot tool
Text Editor.

Help Authoring Tol






_images/quizeditor1.png
LI sICXC)

o ]|

Do you know now what is %elpmarz






_images/createquiz4.png
Do you know now what is Helpinator?

@hosiepnatorfor?






_images/quizlist.png





_images/createquiz3.png
6 Quizzes

+-u

Neme.

[Bhepratoconests





_images/quizfilter.png
File Tools Help

Eg7=w

[Sp==—ry
& aesteen
5] cresteepube
] crestecpubk
5] crestemobic

(b enreatenst
] cestepdon

e
&) cestection
SEe——
IS p—
IS
S
S "

2 en-createwebhe






_images/createquiz6.png
Al NDIOOIT HAEONEORD
® BElEEEE| e z|ve

T Normal text + 17 eaion -

rg‘]‘2‘3‘4‘5‘5‘7‘5‘9‘]‘]‘]]‘]

%QUIZ helpinatorconcepts%)






_images/rearrange-button.png
File Tools Help

ugs-

O0=s55020ARARIES GO =

Q | Topics
+H rebretor =
> {1 Topies) M +BZ2—00n
P keporcs L ®
2 ey = ContextD D B
45 moges o M
(b advanced (=] »
(b en-capturescreenshots. (=] 2 =
b (b en-createchm (=] 30
o en-createepud =] s
b (b en-createpdf (=] 50
b en-createat o W 830
o [ en-reatencbhelp = o0
3L enenbedvideo ] Import xisting documentaton o0
ol ot &} Capture screenshots a0
5l ergodesnippets &} Recapture sreenshots o
8- Pisdons &} Add annotatons tosreenshots a0
6 Py &} Quiddy pdate sresnshots when U changes o0
5l o t-rippets &} Create step-by-tep quides a0
i enguides &} Create CHM help fie 10
8 Pkt &} Create PDF and printed manudls a2
&] Create Webtielp 330
&] Create Qttielp 340
= &] Create Javatielp and OradieHielp 350
BH | Foorsammmmes @
TR o &} Enbed Video from YouTube, Vineo and et 1020
Bona &} Change order and herarchy of topis quickly 1090
[ fibeina &} Greate aFaQ 1130
- S &} Create a Qui 1190
Global Spelcheck Ol 5 cetingstarted n =
£ Tnoge Tools -] [ i






_images/createquiz5.png
Mult select allowed

Optons without text

Options with text (one per ne)

Opton
Screenshot tool
Text Editor

Help Authoring Tool






_images/quizzesnode.png
hepinatorconce
4.5 HTMLbased Templa
defauithtml

epubmobi-defau
javehep-defauit
Notame himl
+-J) PORRTF Print Tem|
) defouterts
Tasks






_images/ebedquizanswers.png
S A @
nppet Code Stprbystep Video Aside/ Admariton FAQ. Que | Anavers

| 5 helpinatorconcepts

(O I I R CENl

 “Helpinator Concepts” quiz






_images/reimport.png
File Tools Help

"=V

O0s50E00ARAORES GO =

7 Q REmport
=]
iz enfocls Topic D Fikpame ~
] checkinks.png E About about h\ M
] contexsdong ] Benefits benefits
[ T Tutorial tutorial
@ |55/ Support support
B ] order order
& s oo rowto
5 {E] wptheme1.png ] Startanew project startanewpr.
{1 wptheme2.png [C] tmport existing documentation importexistin.
4 nopics
e ota.on ] Coptresarcenshots cptresaee
i, ] REcapture screenshots. recapturesa.
] Add annotations to screenshots. addannotatio,
] Quicky update screenshots when UI changes quicklyupdat.
] Create step-by-step guides reatestepby.
] create CHM help fie: reatechmhel.
] Create PDF and printed manuals. reatepdfan.
] Create webkelp restenebhelp
[F] create QtHel. aeateqthelp
] Create Javatelp and OraceHelp aeatejavahe.
T Worcpress Theme e 7] Create E2UB and Mo ebooks aesteenuba u
B GIF Screen Recorder
i Tt B i ] 3






_images/createtopic.png
‘Add Guide

Name:
eateguide

createtopic prg
quidename.png
quideoptions.png
namesteps.png
reordersteps.png

G )






_images/recapture.png
[9) Tools | Screenshot

dowey curn

General | Create topics and guides | Region and Background |

Capture newimage

File name format:
Category

Image format:






_images/editimage.png
File Tools Help

ugs-

{E] useguide1.png

Qs> yE20AM| [@ B st

ID0000000000000O00E]
3 7 4 5 0 0 O

[

] rope sicure

8
g
§
g
§
g






_images/replacebitmap.png
v

Extend Image Canvas
Show Grid
Replace Image (Frém File)
Replace Image (From Clipbba
HTML Properties
Exportimage..

Change active region
Stop changing active region
Effect for inactive region »

Crop image to active region

Make this image a clone of...

Unclone






_images/editimage-shape.png
Extend Image Canvas
V| ShowGrid

Replace Image (From File)
Replace Image (From Clipboard)
HTML Properties

Export image...

Change active region
Stop changing active region
Effect for inactive region »

Crop image to active region

Make this image a clone of...

Unclone






_images/reordersteps.png
Guide Name
Add Images.
Create Topic
Name Ste

Guide Options.
AddText






_images/edittextsnip.png
File Tools Help

Englsh (United Stat

ugs-
Q

wite

Tooks

Table

O=s>YEeIARNOEEY OO

@ v
Sample Quiz
+{{JFaqusts
FAQEdior Overview
How to Enbed aFAQ
Somple FAQ
[ Quiz answers:
P Kepuords
) Glossary
42 Textsnppets
152 naming)
4177 Code Snipets
(2 hepinstor il
45 Images
4 (b advanced
] batchcompie.P1G
] batchcompie .eNG
] batchcompie2.PNG
] batchcompie3 PNG

R P —

Quizzes Editor Overview

|8 W — | ® 2 wal

T

Normal text

T Tetalgn -

larning

Tools & Reports

= repors
] Topic Tites and s
] Emoty Topies
{] Tasks by topics
[ project stats
T Toic Structure

i)

ORSNIPPET%)






_images/pdf3.png
Fle Edt View Toos Comments Forms Help

|l &

) Getting started
8 Project
1) Topics and Content
(I styies
{£y 1mages
1) Step-by-step Guides
) Text Snippets
1 Code Snippets
1) Templates
£y Tools
) Reports
8 ToDo List
[ ) Formats
1 Advanced Topics
11 addimagefromie

"5 . resteimages

oy
Elsnnmnaaanananns

.

[P
[

Enrn

e

=S
T

s sk s

B3 newhiankimaae.

8 ©[87(87/88)






_images/createfaq8.png
{Questins_________________
+=-00

Queston

@newraq Queston






_images/projectoptions.png
/
=
=

© File Tools Help

U

ug7

Ql

Englsh (United States)

4 rebinator
L] Topis:
P Keywords
2 Glossary
45 Images

advanced
encaptiresareenshots
en-reatechm
en-reateepud
enreatend
enreateat
en-reatenebhep
enembecvideo
enformts
eng-code snippets
eng-editor
enggio
eng-text nippets
engudes
enimages
enimport

Tools & Reports

4R Tooks
= 5 search &Replace
o Context s
@ Sareenshots
Globalspelicheck

£ Image Tooks

General

Tempiates.

Project Tite:
Helinator

Defaut Topic:

Defauit Font:

Auto generate Context ID
Auto Index

Auto number topics on output

Create *_meta.uni”fie when possble






_images/createfaq5.png





_images/print.png
D%\\wvwkw\ﬁpﬁ

5

Hopnater

Pagelofiss %3






_images/createpdf.png
usesnippet
S Vo
] Aboutieinator
4557 HTML based Tempiat
[§] defaithimi
J5] epubmobi-defaul
Jo] javaheip-defaut.

£ search aREplace

Image Tools
CheckLinks.
Tasks.






_images/projectoptions2.png
General

Units

Left Margin
Right Margin
Top Margin

Botiom Margin

Orientation

Faper Size

) Header Height
el Foster Height

—9

—

M






_images/createmobikindlegen.png
@ www.amazon.com/gp/feature htmlie=UTFB&docld=1

AMAZON osmsncon  Toosyspeas  Gncrss

N—7\in brime

‘Shop by .
Department~ Search  inde store

Kindle Store  Buy AKindle Free Readng Apps  Kindle eBooks _Kindle Singles

KindleGen

KindleGen is a command line tool which enabls
automated environment with a variety of source ¢
or EPUB. KindleGen converts this source content t
both KF& and Mobi formats enabling publishers t
that work on all Kindle devices and apps.





_images/projectoptions1.png
General | Page

Author

Versian

Subject

Keywords






_images/createpdf2.png
T —

Templte name

@ Buitn:
= —
Fors POF, RIG@RINT

© From Fie: For PDF, PRINT

Preview






_images/projecttemplates.png
DsxrEeoARORE S ®

[l Project options

Englsh (United States)

General [ Tempiates | Variables | webrielp

Project Tite:
o| | Febinator

et Tepcs
Sapesaeenets
oout

—
i, 5, DEFALLT_GHARSET =

DefatLanguage:
[Engish (United states)

R Tooks
D search aReplace
58 ContextIDs.
e
v
ot |






_images/createpdf1.png
11 - E\DIMON\Projects\Delphi\Productivity Software\H

Help Unregistered

1| w R [0 [m] £

{E] rtftemplates®
{E] templatenode

1 en-tooks
) contex e
] magetoole et
{E] searchreplace Beetoser
ISP

{E] addsevtopics
{] managetopic:
-





_images/projectstruct.png
Code snippets

Project

=,

Guides

.
"





_images/createpdf4.png
YERs0ADMm Ol

B v.‘gm options

Defaut Font
‘Arial, 8, DEFAULT_CHARSET





_images/qthelp1.png
o

File Edit View Go Bookmarks Help

€~

B[

Contents

-

Bookmarks

saeaq

Index.
Look for:

Advanced Topics > Conditional compilation

Conditional compilation allows you to modify Helpinator output based on values

| of user-defined variables.

It may be used in both of two ways:
1. To skip portions of text
2. To skip one or more topics entirely.

To skiplinclude portions of text Helpinator has builtn IF directive which has the
following syntax

TG EDTON=PR03)
This text will be shown only when EDITION variable is set to PRO'

($Ends}
(§Comment$}

This is comment. It wont be shown anyway

{$Ends]

In the first case IF clause allows to skip the text inside it when "EDITION"
variable has "PRO" value.

In the second case the text wil be skipped without any conditions. This makes

Open Pages

Conditional compilation

& x| COMMENT tag 2 good way for text reviews

To skip a topic from output completely (e.g. even from TOC) there's "Skip topic”
tab in the topic editor

il ] V-






_images/createpdf3.png
General | Tempiates | Variables | webrielp

=

=
RTF Template (Language Specific defol
| | PoF Template (Language Speciic) defol
i, | | Print Template (Language Specific) defol
'+ | | Qe Template (Langusge Speciic) defal
Javatielp Template (Language Speciic) avar

- | | EpuB Template (anguage spedfic) epub

AREREEEREE

MOSI Template (Language Specific) epub






_images/qthelp.png
o
File Edit View Go Bookmarks Help

[ Comers ——

tents. 8 x

= Helpinstor
About

Beneits

Tutorisl

Support

Order

Geting Stated

Project

Topics snd Content

Styles

Mansge Glossary

Images

Step-by-step Guides

Text Snippets

Code Snippets

Templates

Tools

Reports

ToDo List

> Formats

> Advanced Topics

" Localizing help files

ompm e

About

€-0- ﬁl LUéL\ ® & q

Helpinator is a help authoring tool for teams and indiiduals who document their
software project themselves. Its relatively inexpensive and not as bloated as big
tech writing packages

Helpinator is a single source tool. You can compile CHM, PDF, RTF, WebHelp and
Printed Manuals all from single source

Helpinator is a WYSIWYG tool. Write content in fiendly environment.

Helpinator is muttilingual. You can have as many project languages s you wish
Work with any translation service you wish using XML Import/Export ™

Check the complete list of benefits on our website:

hitp://wwhelpinator.com/benefits. htmi

oftware






_images/createquiz1.png
-89 usesnippet
ieo
H boutiepiator

Lhe
-@

PDFRTF [Print Temp|
) cefortt
Tass

109

Image Tools -
Check Links.






_images/createqtdownload.png
@ gt-project.org/downlosds

Qt Project

7" QtPROJECT FORUM WIKI DOWNL(
Download Qt, the cross-platform application fram

Download Qt, the cross-platform

Jump to: Qtlibraries ¥ Qt Creator & Other downloads





_images/qthelp2.png
File Edit View Go Bookmarks Help

-0 Ol Vel

e Soomars | semn |
ey %

semcni: v (4[>

Advanced search ———————————

K< 1-90foHits DB

Otttelp -

athelp:/majormindsoftwarehelpinator3.7/d
oc/athelp.htm
Formats

athelp:/majormindsoftwarehelpinator3.7/d
ocfformats.htm

Javahielp
athelp/majormindsoftwarehelpinator3.7/d
‘ocfiavahelp.himl

EPuB

athelp:/majormindsoftwarehelpinator3.7/d
oclepubhtml
081

athelp/majormindsoftwarehelpinator3.7/d
‘ocfmob.himl

PDE/RTE

qthelp:/majormindsoftwarehelpinator3.7/d
ocfpdfitEhiml 2

Open Pages 8 x
Conditional compilation

® & q

R )

Advanced Topics > Conditional compilation

Conditional compilation allows you to modify Helpinator output based on values
of user-defined variables

It may be used in both of two ways:
1. To skip portions of text
2. To skip one or more topics entirely.

To skiplinclude portions of text Helpinator has builtn IF directive which has the
following syntax

TG EDTON=PR03)
This text will be shown only when EDITION variable is set to PRO'

($Ends}
(§Comment$}

This is comment. It wont be shown anyway

{$Ends]

In the first case IF clause allows to skip the text inside it when "EDITION"
variable has "PRO" value.

In the second case the text wil be skipped without any conditions. This makes
COMMENT tag a good way for text reviews

To skip a topic from output completely (e.g. even from TOC) there's "Skip topic”
tab in the topic editor

@l il ] 01|






_images/createfaq4.png





_images/webhelp2.png
ORDER

Getting Started > Output Formats

‘webhelp O“tp‘lt Formy
About

Currently Helpinator si ut formats:
Create WabHelp P "

Output Formats.
WYSIWYG Editor

2
3
a

cude Styles HTML based with navigation and 3 options: with frames, without
Code snippets in help files frames and single page).
Templates 5. QuHelp (@t library native help file format)
'F‘“‘l"‘;m" Templates 6. JavaHielp (ava native help file format)
orma
2 7. EPUB - widespread ebook format
Classic WebHelp 8. MOEI - Amazon Kinde format.

Analytics and Social Integration
Adapt to your website

How to Change Style of the Left
Pane

WebHelp 2

JavaHelp

EPUB.

MajorMindHelp

Wordpress CMS.

9. OracleHelp - help system from Oracle Inc:
10. HelpGUI - a lightweight help system for Java

11. MajorMindHelp - experimental help system for Delphi
12. Wordpress CMS






_images/glo-insert-hyper.png
Topic. [ Inemet | Glossary

HIML
Query
POF
RTF
WebHelp

Cancel






_images/webhelp3.png
Fie Toos Hep

EEEV’R@E@@OA@ mi] » Jolf SRAMWI - IS e

{8l CHM/Web Help Template: defaultwebhelp2.html

Fies | Webrep.

Header

Headerhegnt 0 2]

Header HTML:

<i--neader starta——>
<div ig="neader";

ontainer header_inmer clearfix™
grid_127>

Footerheght 0 ]

Footer HTML:

<div style="heignt: 20px; clear: both"></div>
<div id="footer"> o

<div class="container footer inner clearfix">

<1--list starts-

<m v

Modfied






_images/gifrec.png
/7
=

File Tools Help

uwg7

Os>Y)Ee0Aap0RES DO

‘Gf GIF Screen Recorder

Q

b entasks

b en-templates

4 entooks
{E] cheddinks.png.
{E] contextd.png
{E] gifrec.png.
{&] imagetools.png.
{&] remport.png
{E] searchreplace.png
] spell.ong
{E] tooks.png.

[

4R Tooks
xbseavd\ Repiace

Wihat to record:

wiidth:
Height:

Capture cursor.

Start/stop hot key:

Preview:

e around mouse cursor

Y

o

)

;’)‘ Freen =

Engist

reate GIF






_images/webhelp2demo.png
HOME ~ PRODUCT ~ DOWNLOAD

About
Benefits
Tutorial

Support

Order

Fle Took Hep Unregistered
4 [ How to. wg‘ 2PERASTOM

Import existing

documentation

Capture screenshots





_images/glossary-write-text.png
U

Tools  Help

=P el e

2)0e0AR0EES WO

wrte st [ Table [ Toos |

BIUS@EEEE=:@E% 0 - %6 L v

T Normal text -

T Leftalon -

(= Glossary

Kanban (Japanese &1 signboard or billooard) is a
lean method to manage and improve work across
human systems.






_images/wordpress.png
Publish To Wordpress
Profie:

[WordpressTest e

Account:

Host:
helpiatortest.wordpress.com

[0 UsessL (ttpsi/f...)

Endpoint (leave blank if WP is NOT in a older):

Settings:
Page Template:

ot Poge Temte o secbr

ParentPage:

RootPage Order:

L=}

] WP site uses Helpinator theme with project styles

[] WP site has enabled Helpinator Quick Pubish Plugin

[Coovepotie ] [Remtpote]  [posn ] (oo






_images/globaltasks.png
File Tools Help

ugs-

Engish (United Stat

DsxrEeoARORE S ®

rasks
{E=] quizzesnode.png A
4-{g uncategorized + Qk—

{E] createchm.png.
Bl costming = morty  progess__Toic
& cestechmzpng Updste “about” F —ry
& cestechmapng Rppend goscery eximple 5 B Manoge Gos.
{E] createchm4.png
] enkindeLpng
] pojectsiuct o

457 T based Tempiates

e
ebhep2.rinl

Tavahelp-defauit bt
Kodefaulthml
NoName.htmi

3 Tools & Reports

o P Reports =
] Topic Tites and s
] Emoty Topies
{] Tasks by topics
[ project stats
T Toic Structure

i)






_images/webhelp4.png
File Tools Help

Hu@7z0Ees0AE@

4 H reinetor =
4 Topics: O
About
Benefs
Tutoril

4 ronto..
Sterta new project
Inportexising doc.
Capture screensho’
REcapture sareenst
Add anmotatons to
Quekly update sare
Create stepbyste.
Create CMhep i
Create POF and pri
Create Webriep

OEEs v e

ViebHel | New Templates|

AV WordPress Theme Buider ™

m
[ Project options
General | Templates | Variables
Service
‘i Google Analytics

Create Google Sitemap
BasePath:  hitps v

Modfied






_images/guidename.png
‘Add Guide

Name:
eateguide

createtopic prg
quidename.png
quideoptions.png
namesteps.png
reordersteps.png

G )






_images/wptheme2.png
File Tools Help

uwg7
T

0=+ 020A0DEE & @ wmwwn

¥ WordPress Theme Builder
T hnitemplatessong <
{E] projecttemplates.png. save o
] riftempates.pn
{E] rtftemplates1.png o Parameters | Colors and fonts.
ttempstes2
e
P —— v sedgrond cdor: [T soocacecs []
Tools & Reports Header color: sooFFFFE ]
TR Toos
B searcha Footer color: So0FFFFFE [o]
o conenrs comotcar: [ ] srereee ]
"“"“"mk"" ek Header font: arial | 3 00000000 [7]
CheckLinks =
B oo Foterfonts vl = Bl e
AV Worderes Theme suider .
B GIF Scren Recorder Footer HTMLfPrP:
4 Reports <i—- copyright > a
] Topic Tites and 0s. <p class="copyright">
gm;ym &copy: <?php echo date('Y'); 2> Copyright <?php bloginfo('name’);
topies <a nret=//wordpress.org" title=TWordPress">wordPress</s> Gamp; <
[ o brie






_images/glossary.png
| File Tools Help

2P

QoAROEE2 v e

wal7
a

wite

@

+H reprator
o Topics:

([ Code Snppets
45 Images

advanced
encapturescreenshots

encreatespud
encreatepdf
enreateat
enreatencbhely

Tools & Reports

+ { Reports =
s ——

] Enoty Topis

] sk by topics

O proctststs
] Topcstrctre

FEBINE -k S L

Engish (United Stat

T

(=) Glossary

ms | U= ]

Term
am
ML
iQuery
POF

RTF
Viebrelp

Microsoft Compiled HTML Help is a Microsoft
proprietary online help format. It was introduced as the
successor to Microsoft WinHelp with the release of
Windows 98 and is still supported in Windows 7.






_images/wptheme1.png
© File Tools Help

uwg7 Os>YEe0AROEEY DO

7 \§V Wordpress Theme Builder
=]

enoptons 2
" Save theme to:

enproject
enveports

ensareenshots Parameters [ Colors and fonts|

vy paen vae

en-templates: Theme name Helinator

en-tools Theme URT http:/ . helpinator.com

@

@ ] cheddnks.ong Descrpton Crine documentation them fo use it Helpnator
F {E] contextd.ong Author Dmitri Popov.

g ghecins AuthorURI it . dirpopov.com
& masetod ng verson 10
= ] remportong

5] se tretoce.org Togs softnare documentaton, ariine do

& pelong TextDoman hepinstor

Leense

[Clinciude all my project styles (makes your WP pages smaler)

SR TE‘Z ek + || 3queryu1 path =
g::z*::s:’: tsospen

Global Spelceck. (100x100 PNG image)

]

480, Worderess Tieme Buider |
GE GIF Screen Recorder
4T Reports 2

Create theme






_images/faqlist.png





_images/variables.png
© File Tools Help

a7z B2 0ER0ANDEIE# @ @B wwuwsew
Q [ Project options
o ] Vo [
Variables (For All Languages) | =l
Vo Ve :
PROGRAMNAME Helpinator (]
o i
Comminve [
. e 4
| 2= i
Variables (Language Specific)
Vo Vo
+= 4
-
o ContextIDs.
~ Pt
sk
£ Image Tooks -






_images/faqeditor2.png
B o B i o ol om0 Y

 the program i caled Helpnator?.

Vihy the program i caled Helpator?

Good question! It was named in a homage to author's
great-uncle who coincidentally was named Helpinator.
Just kidding. For no reason actually, other that
awesomeness.

>






_images/usetextsnippet1.png
CIREE A

Wde  Back Fowad Home
Conterts | index | Search | Fat ||
2 About
[2) Benefis [Text Snippets > How to use text snippets
2] Totorial

2 Support

2 Order

2 Ul Ovenvew

@ Geting Started

@ Topics and Content

@ styles

(2 Glossary

2 images

[2] Step-oy-step Guides

& (1 Text Snippets

Example usage of a text snippet

©201

@ Coce Srppets
2] Templates

2 Tools

[ Reports

2 ToDo List

@ Formats

@ Advanced Topics

i D






_images/filtertoolbar.png
File Tools Help

Eg7=zy

] aeatespub ~
Sp—r
5] cresteepube
] crestecpubk
5] crestemobic
4 {ib enreatepdt
] aeatepcipn
] aeatepets

{E] createqtdon.
] en-createat

{E] en-createqt|
{E] en-createqt =
{E] en-createqt|

S "
2 en-createwebhe






_images/webhelp1.png
benefits

ORDER

Topics with keyword "chm'

1. Formats
the following output formats: chm (Compiled HTML Help) PDF RTF (with

2.CHM

chm Helpinator uses Microsoft HTML Help _

3. Templates
~based templates for producing chm help files, WebHelp, QtHelp, Javatielp.

4. HTML-based Templates
HTML-based Templates Each chm/WebHelp template consists of two






_images/faqsnode.png
457 HTMbased Tengla
defot i
eoutmabicefau
ovahelpdefaut
Notameinl

4§ PoFRTF Prnt Ten]

) cefortt
Tass

Lo






_images/webhelp.png
HOME  PRODUCT  DOWN ORDER

' About

[ Benefits
[ Tutorial
[ support
[ order
D How to...
[0 Getting Started
D eroject
[0 Topics and
Content
M styles
[) Manage Glossary
M1mages

[ How to Work With
iden

About

Helpinator is a help authoring tool for teams and individuals who document their software
project themselves. It relatively inexpensive and not as bloated as big tech writing packages.

Helpinator is a single source tool. You can compile CHM, PDF, RTF, WebHelp, Printed Manuals
EPUB and MOBI ebooks, JavaHelp, OracleHelp, HelpGUI all from single source. You can even
publish your online documentation to WordPress!

Helpinator is a WYSIWYG tool. Write content in friendly environment.

Helpinator is multiingual. You can have as many project languages as you wish. Work with any
translation service you wish using XML Import/Export.™

Check the complete list of benefits on our website

http://www helpinator.com/benefits htm





_images/formats.png
© File

U

Tools  Help

Startanew project
Import exsting doc.
Capture sreensho
REcapture screensl
Add amotations to
Quickly update scre
Create step-byste
Create CHMhelp fi
Create PDF and pri
Create Webtielp

D

Engish (Unite

Defaut Topic:

About

Defauit Font:

A, 8, DEFAULT_CHARSET.

Default Language:

[Engish (United states)

[¥] Auto generate Context ID

4R Tooks

5 search &Replace
o Context s

@ Sareenshots
Globalspelicheck
Imoge Tools
& e
2 Remport
T Worderess Theme Bulder

Modfied






_images/enoptionsjavahelpcompiler.png
Options... =

General | Language stings | Compiers

CHM: Path to HHC EXE wilty (HTML Help Wotkshop)

@]

tHelp: Path to QSDK BIN folder:
DAGISDK\Deskioph D\ 8.1 mingtbin

Javahel: Path to JavaHelp SDK BIN Folder
D22 Oavahelpibin

0 B

JavaHelp: Path to JDK BIN Folder:

CAProgram FlestJavatidk1.7.0_13\bin

@]

OracleHep: Path to DracleHelp Folder
DAGHI

@]

MOBI: Path o KindleGien uily:

DiAKindleGien

@]






_images/useimage.png
=00AD O

3

Wite | Insert [Table |

e scenier
.| e
B

8

You can use images i





_images/useguide2.png
2 B (= A @ Ry~

Biture.. Sccershot/ Figure Sppet Code Step-by step Video Asde/ Admorition FAQ. Qute Answers

rg RN R R SR Y RS KRS K- KOS - RNS S ENS F IS € RS C IS CEN RS CRNS VIS - IR

1. Prepare images.

Prepare images for your quide. You can add existing images to the image brary, capture some sreenshots or create doned images. Add
callouts using mage editor to emphasize meaning of the corresponding step.

<123456789101112>






_images/enoptionsoraclehelp.png
Options... =

General | Language stings | Compiers

CHM: Path to HHC EXE wilty (HTML Help Wotkshop)

@]

tHelp: Path to QSDK BIN folder:
DAGISDK\Deskioph D\ 8.1 mingtbin

Javahel: Path to JavaHelp SDK BIN Folder
D22 Oavahelpibin

0 B

JavaHelp: Path to JDK BIN Folder:

CAProgram FlestJavatidk1.7.0_13\bin

@]

OracleHep: Path to DracleHelp Folder
DAGHI

MOBI: Path o KindleGien uily:

5 \Windien =]






_images/usesnippet2.png
g Unedsttes)

Oesm—H>
|| pelingtorhtmt
+ 17 eaion






_images/enoptionskindlecompiler.png
Options...

General

Language stings

Complrs

CHM: Path to HHC EXE wilty (HTML Help Wotkshop)

tHelp: Path to QSDK BIN folder:
DAGISDK\Deskioph D\ 8.1 mingtbin

Javahel: Path to JavaHelp SDK BIN Folder

@]

DAGHI

D22 Oavahelpibin

DiAKindleGien

JavaHelp: Path to JDK BIN Folder:
CAProgram FlestJavatidk1.7.0_13\bin

OracleHep: Path to DracleHelp Folder

MOBI: Path o KindleGien uily:

0 B

0 8 B8






_images/usesnippet1.png
tor.hpz (Registered to Dmitri Popov)






_images/faqeditor.png
Queston
@y the proord

<

imis called Helpinator?

il v

Vihy the program s

called Helpinator?

Good question! It was named in a homage to author's
great-uncle wihiy coincidentally
Just kidding. For no reason act

awesomeness.

[ >






_images/usetextsnippet.png
| File Tools Help

ugs-
Q e

[H Helpinator 3
4 1] Topies
T styes
[ Textand Paragraph Syl
# {[] Textsnppets
[ How to use text sppets
4 4[] Tods.
[ Context s
4[] Advanced Topics
[ Organizng textrevens
B Text Sippets
45 mages
4 (b advanced
5] eng-cond-text.png
+-{ib engrextsrippets
] editextsnip.ong
5] mansgetextsrip png
1] usetextsippet.ong
5] usetextsninpetLpng

Tools & Reports

4P repors =
] TopicTites and 0s.
{] Empty Topics.
] Testsby topcs
{0 rojectstats:
{0 Topicswuctre

B

ring

Code Step-by-step Video Aside/ Admonition FAQ Quiz

(= A @ B

I R R KRS RN RS RN PR EERRS T AT |

_ d edit
topics with your application, in one list

xt IDs, used to connect help files

General [TaDo_| Notes | Anchors | Skip topic [ HTML.
TopicName:  Context IDs.
contextds. ContextID: 550 ©
context, tool






_images/enoptionsqtcompiler.png
Options... =

General | Language stings | Compiers

CHM: Path to HHC EXE wilty (HTML Help Wotkshop)

@]

tHelp: Path to QSDK BIN folder:

D22 Oavahelpibin

@]

JavaHelp: Path to JDK BIN Folder:

CAProgram FlestJavatidk1.7.0_13\bin
OracleHep: Path to DracleHelp Folder
DAGHI

=]

MOBI: Path o KindleGien uily:

DiAKindleGien

@]






_images/usesnippet3.png
{%CODE heibinator htmi%)






_images/eng-ed-todo.png
General | ToDo | Notes | Anchors | Skip topic [ HTML.

[rext Priority Progress
Update "about” El —

Femm] [






_images/tutorialnewprojectgeneral.png
General [ Topics and Keywords | images [ Templates|

Englsh (United States). =

Addtonal Languages:
[French (Canada)

SaveTo:

© Singfie, zp-compatble (“hp)
C:Projecthepmnkarban.fpz

© Ves-compatbie, folder






_images/eng-ed-template.png
General [ ToDo_| Notes | HTML Template

Anchors.

© e Longisge-spesiic defaul el
(© Use Selected Template:

it






_images/tutorialminikanban.png
File Board Help

rHe

& Minikanban v.1.1 - CAMylife\kanbanboard.kan (Registered to: Elon Musk)

Backiog «

# Haveavacaton

Inprogress. «

) sellsome fimethvoners

Done. «

@ Mary Justine.

100]

& v \edding Neuests.sis

() marriage
) Hire a wedding consutant
\Buy rings

%

@ Marry Takich
"100]

& Cife\Wedding NeZlauests. s

) marriage

£ Hire a wedding consulant

By rngs

%

[} Divorce Takish

@ Morry Takich Agan

& v eding NeYuests s






_images/eng-ed-toolbar2.png
Undo and Redo

Search and replace:

Insert code snippet

Insert hyperink Insertanchor Insertsymbol

Insert table

A méu\@"wi@a NEoRSYd L RED i 2
BEDgE == ’\ *}9\’“‘ et fe—
T Norhaltext - " e ign
) Sl ke undene [| rexcain || msertiextsnpmet i‘"w‘fq‘j;j“‘ev [ merthoryzontal 1 ot pagetrea 2R

Helpinator s a help au

g packages.

oring tool for

eams and indwiduals wr

0 document ther sof

are project themselves. s relatively inexpensive and not





_images/uioverview.png
File Tools Help

Englsh (United States)

O0s>YEe0ARORES OO

Options

BOIaEN

Defauit Font:
Aial, 8, DEFAULT_CHARS:

D

B DefauitLanguage:
Tools & Reports Engish QUnited States) =
4R Tooks
5 search &Replace Auto generate Context:

o Context s Aot Index.

o) Sareenshots
Global Spelicheck Auto number topcs on output

é Inage Tooks reate " meta " fie when possble

CheckLinks.

5 e [ rorpronseoms.. |
A{V Wordpress Theme Buider PDF Print Settings...
[ e

+ (T repors
] TopicTites and o5

] Emoty Topi
] Tasksby
{] projectstaf

] rope sicure






_images/eng-ed-toolbar.png
Preview and Pring text in the ecitor Insert image InsertFAQ Insert Quiz Insert flash

Cut, copy, paste Insertimase

/ Fromlbrary Insert Quiz Insert table
Answers

Eas oplooez diarord BB n — R4 @ B o wm b d-aat >
B

2% Al v w3
sEEEE e2l%e W K

T Normal text leftaign Row and column
IS Insertlist Spelcheck Font selector alterations
rg‘ T DR 7‘\5‘ (RIS RS IR NS RS VIR Y 2
Hef S oring tool] _ "aresrenh stvie who docu Edior area fthemselves. It's relatively inexpensive and not
extstyle
i






_images/tutorialnewprojecttopics.png
General | Topics and Keywords | images | Templates|

Topics one topic per ine, identify levels with TAB):

About
Support
Order
Gettng Started
"Main Menu
Toobar
Tutorial
‘Add Board Item
"Move items between columns

Keywords (one per ine):

Kanban
Board
Cheddst
Tag
Attachment]






_images/eng-ed-write.png
e .

Write. 't | Table | Tools,
HEEEEEE R L - SN
T Normal text + T eraion
4 4

Ipi
Ipi

Bom a2

vely inexpensive and not

[ rce tool. You can compile CHM, PDF, RTF, DOCX, WebHelp (Classic and New WebHelp2). Mobile, GitHub-flavor
Javaiieip. OracleHelp. HelpGUI all from single source. You can even create software documentation WordPress themes and publish your onl

1 is a WYSIWYG tool. Write content in fiendly environment.
v is multiingual. You can have as many project languages as you wish. Work with any translation senice you wish using XML Import/E





_images/eng-ed-tools.png
h [ams and indiiduals who document their software project themselves. Its relatively inexpensive and not s blo

si compile CHM, PDF, RTF, DOCX. WebHelp (Classic and New Webelp2). Mol itHubflavored Ma
cl6FETp, HelpGUT all o single source. You can even create software documentation WordPress themes and publish your online doc
"HelpImator 1s @ WYSIWYG tool. Write content in fiendly environment.

Helpinator is muttlingual. You can have as many project languages as you wish. Work with any translation service you wish using XML Import/Export™

Check the complete list of benefits on our website:





_images/useguide.png
RS N RN R RS R TR i






_static/file.png





_images/capturescreenshots0.png
[9) Tools | Screenshot

Hotey:  cat +Fiz
General | Creae topics and ides | Regon and Background
Exphrmuimgd

File name format:  capturescresnshots. X%






_images/import4.png
2 Import eisting help il and docs
Source Type
Hepinator LX/2Xproject (*HGL)

© amfie

Source.

CoProjects Hepinator help help|

Destnaton Type
@ Single-fie project (*pz)

Destnation

[E=SECR =)

HTML Help compler project (*HHP)

RTFHTML/TXT/DOC fies:

ood for VCS)

CoProjects Hepinator help helpinator.pz

¥

Language:  (Engish (United States)

Progress
Ready






_static/plus.png





_images/import3.png
2 Import eisting help il and docs
Source Type
Hepinator LX/2Xproject (*HGL)

© amfie

Source.

CoProjects e

Destnaton Type
@ Singl-fie project (*pz)

Destnation

[E=SECR =)

HTML Help compler project (*HHP)

RTFHTML/TXT/DOC fies:

Mutple fies project (good for VCS)

CoProjects Hepinator help helpinator.pz

Language:  (Engish (United States)

Progress
Ready






_static/minus.png





_images/capturescreenshots2.png
[9) Tools | Screenshot

Hotkey:  Crl +F12

General | Create topics and guices | Region and Background

Offsetleft: 100 |& OffetRioht 100 | OffsetTop: 100 |

[ capture mouse cursor
[Ecapture Background

[Jorop shadow






_images/import6.png
2= Import existing helpfiles and docs o]
SourceTye
Helpinator 1.X/2.X project (*.HGU) HTML Help compiler project (*.HHP)

© amfie RTFHTML/TXT/DOC fies:

Source.

C:\Projects\Helpinator help helpinator.chm ]

Destnaton Type
@ Single-fie project (*pz) Mutple fies project (good for VCS)

Destnation

CoProjects Hepinator help helpinator.pz

Language:  (Engish (United States)

Progress
Ready






_static/up-pressed.png





_images/capturescreenshots1.png
[9) Tools | Screenshot

Hotkey: ol +F12

General | Create topics and guides

Regon and Background

[ create topic

[ create guide:
[C Append To Guide:






_images/import5.png
2= Import existing helpfiles and docs o]
SourceTye
Helpinator 1.X/2.X project (*.HGU) HTML Help compiler project (*.HHP)

© amfie RTFHTML/TXT/DOC fies:

Source.

C:\Projects\Helpinator help helpinator.chm ]

Destnaton Type
@ Single-fie project (*pz) Mutple fies project (good for VCS)

Destnation

CoProjects Hepinator help helpinator.pz

Language: - [Engish (UnitedStates) s

Progress
Ready






_images/chm.png
[2) Benefis
2] Totorial
[2) support
(2] Order
@ Howto,
@ Geting Started
@ Project
@ Topics and Content
@ styles
[2) Manage Glossary
@ images
(2] How to Work With i
@ Step-y-step Guides
@ Text Snippets
@ Code Snippels
@ Templates
@ Tools

[2) Reports

[2) ToDo List

@ Fomals

il

Helpinator is a help authoring tool for teams and individuals who
document their software project themselves. It's relatively inexpensive
and not as bloated as big tech writing packages

Helpinator is a single source tool. You can compile CHM, PDF. RTF,
WebHelp, Printed Manuals, EPUB and MOBI ebooks, JavaHelp,
OracleHelp. HelpGUI all from single source. You can even publish
your online documentation to WordPress!

Helpinator is a WYSIWYG tool. Write content in fiendly
emvronment.

Helpinator is muttlingual. You can have as many project languages
s you wish. Work with any translation senvice you wish using XML
Import/Export.”

Check the complete list of benefits on our website:

hitp://wwnw helpinator.com/benefits htm






_images/kb1.png
rofie: [pafaut

JEBE=E03@

Structure | populr | Recent | Tite

[ Generate automatically

D recapture screenshots.

B capture screenshots’

B creste PO and printed manuals
B creste webrep

B creste atrep.






_images/checklinks.png
File Tools Help

Englsh (United States)

Osx o] + Jloll 2NANIL )

(2] Tooks | Tinks.
b = — «/-
Topic LnkType  LnkText Lk
Tutorial (0] wiebrich 2 Webste  https/fww helpnator.comfhelp.
Soepert [ avep Webste  htipi/jdoc.qt.dgia.comjatathe... htp/jdoc.at... Replace
How | 351 JavaHelp Website http:/fdownload.java.net/iavad... http:/jdownl... Replace
E [ SmoleDocserver Wiebsite o /. elinator.comjsim..._ s .

DEE O

’

s

5 search sReplace

I [0 Literelo Webste  higgi/www helpinator.comfite. . http .
Add annotatons o sree

Quickly update screenshc

Create step-by step guic

Create CHM hein file =

& Retmport LD
AV WordPres Theme suider
B GIF Screen Recorder

4 {7 Reports. J






_images/insertfigure.png
ADQEEZ DO s

Table

Tooks

= e
. [Scacendhot Figue]Sigpet. Cote Stepy-step Vi Acie Adhonit

A

Paste screenshot from Clipboard
Quick search for an image

Editor N

Uncategorized

Insert Screenshot / Figure From File...

Ctrl+Alt+V.

eng-ecinsert
eng-ed-tablep

eng-ed-tools.p
eng-ed-write






_static/up.png





_images/chm2.png
2 Helpinator
A

Hde Back Fowad Home Pant  Options

Cortents | Index | Search [ [«

Type inthe wordis)to search or:

an .
(o
Soeaope._rana:2

Tee Location  Ra
Create CHM .. Helpi.. 1

Helpinator uses Microsoft HTML Help compiler to compile &[] help
fles. You need to install it prior to compiling (8411 otherwise
Helpinator will report error. You can download it from Microsoft
website or install htmihelp.exe from the same zip archive with
Helpinator setup.

Formats Helpi.. 3 Helpinator automatically generates "Previous/Next", "Breadcrumbs”
Commandiin... Helpl.. 4 and "See also” lists

Muliple langu Helpi.. 5 I you have Glossary in your project - it will be compiled into [E31J fle
Templates  Helpl. 6 as well

HTHL-based.. Helpi.. 7 To connect your G211 help file to your application you need to know
Guide Styles  Helpi... 8 Context IDs of topics. To get them in printed form you can run "Topic
Wethelp  Helpi.. 9 | || Titles and IDs" report under "Reports” node of the project tree view.
Glossary Helpl. 10

‘W:rslwve £ el : " oy

Search previous resuls
Match simiar words
[T Search ttles only

CIREE A
Hide Back Fouad  Home Print Options.






_images/kb2.png
TEEE
Structure | Popuiar [Recent

Tite.

ZlRendom on

+—006






_images/chm1.png
o]

© e &4 O

“
Hde Back Fowad Home Pint Options

= —
ndex D
S| Bl , Benefits

Check out the complete list of benefits here:

hitp://wwnw helpinator.com/benefits htm






_images/kb2-2.png
KnowledgeBaseSettngs
e [ SISy

Structure | Popular |Recent | Tite

Random popuier artdes

Create G hdp e
Create FDF andprinted manuals






_images/advanced-rearrange.png
Advanced Rearrange.

Benefits {benefits}

Tutorial {utoria)

Support {supporty

Order {order}

How to... frow
it a new project {tartanenprojecto}

Import existing documentation {mportexistingdocumentation

Capture screenshots {czpturescreenshots)

RECapture screenshots {recapturescreenshots)

‘dd amotations to screenshots {addannotationstoscreenshots}

Quickly update screenshots when Ul changes {quicklyupdatescreens!

Create step-by-step guides {reatestepbystepguides},

Create CHM hep fle {createchmhelpfie} 2

‘ i D

Increase Level | [ DecreaseLevel

Hints do not remove topic ids at the end of the topic name.
CHl+[Ctr-+V to cutfpaste topics.
Insert TAB to increase levl,

oK Cancel






_images/import1.png
2 Import eisting help il and docs
Source Type
Hepinator LX/2X project (*HGL)

© awmfie

Source.

CoProjects Helpinator el

Destnaton Type
@ Single-fie project (*pz)

Destnation

[E=SECR =)

HTML Help compler project (*HHP)

RTFHTML/TXT/DOC fies:

Mutple fies project (good for VCS)

CoProjects Hepinator help helpinator.pz

Language:  (Engish (United States)

Progress
Ready






_images/addtext.png
Add Guide
Name:
eateguide

addtext.png
createtopic prg
quidename.png
quideoptions.png
namesteps.png
reordersteps.png

<[ i ] f

Enter name of the guide. This name il be Gsed in 585 placeholder.





_images/import.png
)\ Foxit Reader
B Games
11 Gexperts for RAD Stucio XE2
J: Google Chrome
J. Helpinstor rofessionsl

= Convertto Helpinator 3 Project
@ rep

18 Helpinstor






_static/down.png





_images/capturescreenshots.png
I






_images/callout-add-caption.png
(NodeProperties ==

Shepe [Sule_| Options | Hyperink

Caption:
Listof actons z

Caplion Placement

otz von: (Gt <] magn &

Shape

© Rectangar Rhombeidal
Round Rectangulr Pertagondl
Elpic Hesagaral
Trreer

oK Cancel | [ oot






_images/import2.png
2 Import eisting help il and docs
Source Type
Hepinator LX/2Xpr

© amfie

Source.

CoProjects\Helinator help helpinator.

Destnaton Type
@ Single-fie project (*pz)

Destnation

Mutple fies project (good for VCS)

CoProjects Hepinator help helpinator.pz

Language:  (Engish (United States)

Progress
Ready






_images/htmltemplates.png
File Tools Help

ugs-

Q

S PER0M

5] HTML-based Templates

Engish (Unted States)

& qustong o
5] auzzesnode.prg =y P2
o o 2
frm.ong Name
e &l defuit
bhmz.ong Jol defaultwebhe bl
e Sl ubmobicetaatvim
[ElenindeL.png 18] avahelp-defauit.html
plectstruct.png 6] kbdefauithtmi
4[] FTM_based Templates| # Notiame himi

Notame.himl
4 {5} PDF[RTF Print Templates
@) defauit.rtf a3

0 tos

2R Tods. =
5D search Replsce

‘o ContextIDs.
o) Screenshots.
lobal Spelcheck.

£ Image Tooks a






_images/{C07702C6-836E-464D-BDB7-3F2906134B7C}.png
2 Helpinator 4 Professionsl - CAl\helpnstor
Fie Edit Toos Help

B 2 @D 9| @ e ez






_images/{B9F6839E-6B6B-4073-B60A-3981907DF019}.png
File

Edit Tools

=

Helpinator 3.5 Professional - C:\1\helpinator.hpz (Reaistered to Dmitri Poj

Help

e )






_images/add-glossary-terms-empty.png





_images/htmltemplates2.png
© File Tools Help

Owa7z OS> YER0ANAEEZ U@ = e
s 2 o]
b en-tomes =
o eni Fies | Webrieh
= I3 en-webhelp.
) - en-norkitvideo Header
o faists
4 Sacli desderbegt 130
- suide reatefaq endr b
I3 uide-createquiz -
¢ i “ <IDOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://wee.w »
b athel ptml> [
8- i <nead>
- Uncategorized
4-(5]] FTMLbased Tempiates -
Jo] defaithimd <
Jo] defauitwebhelo2 himl
epubmobi-efait il
javahelp-defauit.html Footer
Jof todefait i = | Footerheont 0 2]
Notame.himl
I3 @ PDF/RTF [Print Templates Footer HTML:
Log e <!DOCTYPE HTML PUBLIC "-//W3C//DTD HTML 4.01//EN" "http://www.w ~
<ntml> £
Tools & Reports [<head>
TR Toos z -
D search aReplace o
8 ContextDs
@Saeensﬁus
Global Spelcheck
5 Image Tooks -






_images/htmltemplates1.png
File Tools Help

uwg7

Besz0H@0AE@

Englsh (United States)

OEEs v e

J6] javahelp-defauit.htmi
Jo] todefat i
7 Nobiame.hiri
© R Tt ramdaten

Jof defautuebhebzhim =
epubmabi-defult il

o}
'l enpltenodesng
oG ook Fies [ webrich)
7 il - 5 <1bocTYPE ETML> =
K <ntml>
- en-nebheip prg
> 1 envothvdeo sl Saeta http-aquiv—rConcentTyoe! contes
Plbdes Saeta name genizacort content—!
. Zm e crentefg <title>{3TITLES}</title> L
<link rel="scylesheec” type="cexc/css|™
| auide-reatequiz ¥ Additonal S v
S
> B athel> container">
o
L Uncategorzed .
4-5] HTML-based Tempiotes headex” cellspactng
o] defauithimi|

Tools & Reports

4R Tooks
= 5 search &Replace

o Context s

@ Sareenshots
Globalspelicheck

£ tmage Tooss

<td width="72">
<div id="logo'
<ing sro=rhel;
</div>

</tas

<ni>(sTT






_static/ajax-loader.gif





_images/addimagefromfile.png





_images/imagelibtools.png
(&} Image vLibrary






_static/comment-close.png





_images/add-glossary-terms.png





_images/imageactiveregion.png
i
Al v/ showGia

Change active regibon

Stop changing active region
Effect for inactive region

Crop image to active region

Make this image a clone of...

Unclone






_static/comment-bright.png





_images/addsevtopics.png
Add Topics

Topic 1
Topic 1.1
Topic 12
Topic 2
Toic 21
Topic 22
Topic 3
Topic 31
Topic 32

*Start new level with TAB

oK

Cancel






_images/imagetools.png
File Tools Help

uwg7

DsxrEeoARORE S ®

(=) Image Tools

Move Images To The Library
Moves al topics images to the image brary with optonal format conversion.

Flemetts






_static/down-pressed.png





_images/addimages.png
‘Add Guide

Name:
eateguide

et ong
eatiobitmg
oadenameng
Sidcopsorain
o
e






_images/images.png
File

Tools  Help

R Tooks
5 search &Replace
58 ContextIDs.

s
Glbal Spelheck
Image Took.
&
£ remport

Worderess Theme uider
B GIF screen Recorder

- keywordseditor2.PNG

- keywordseditor3. NG

L pastefromcipboard NG

£ en-capturescresnshots.
capturescresnshots.png
capturescresnshots.png
capturescresnshotsLpng
capturescresnshots2png

[ereatechm10.png

£ enreateepud
createepub.png
aeateepubLpng

(Urited st






_static/comment.png





_images/guidesselected.png
=] svariables.png
{E] tasks.png.
1] tempbuider.prg

{E] textforsnippet.png
] textsnippets.png.png

4R Tooks
£ search aReplace






_images/{264733B0-0907-4710-BF67-CFFF8D2A5163}.png
£ Helpinator 34 Professions! - C\1\hepinstorhpz (Regisered to Ditr Popoy)
File Edt Tools Help

LEIZ 20090 swnvwsen - dp=






_images/guideoptions.png





_images/{24E4B81A-84E6-45BE-9470-B9064C2951C1}.png
i5 Helpinator 3.5 Professional - C:\1\helpinator.h
File Edt Tools Help

waz =

istered to Dmitri Popov)

i s~ =






_images/helpgui.png
File Action Bookmarks
PSR
Helpinator

B About Ul Overview
) Benefits
B Tutorial Getting Startes > Ul Ovenview
B support

B order

Geting Started

B [Ur Overview]
B) Project Structure. =
2 stnanewsrosct | | [ 18 Hepintor - EXDIONPrjecnDelohPrcuctty SotwareHepnstoniel

B output Formats File Tools Help Unregistered

Helpinator has classical explorerike Ul with open/compile poject buttons on the main toslbal

o @ Project =
- 7 2NPuAD L Ee|
o B stes

[B) Manage Glossary
> @ Images

& B Step-by-step Guides
o B TextSnippets

o B Code Srippets

o B Templates

= Gossary
B Text Sippets
51 Code srppets
) images

L 88 Step-by-step Guides -

8 Toos i imasetremoes |||
B Reports o @) POFRTFrint Templates | | petasttronts
2 reoo e A e 5, AT G

o B Formats Q‘seay &Replace

Coent s )

o B AgancedTopics 3 coveon T

o B Localing help les [l e a—
B clossany 2 e

Il D






_images/guidestools.png
Step-by-step Guides
+ 7=

Name






_images/{3737ADA8-A871-4A9C-A9D5-BA21C0DDFB78}.png
3 Helpinator 34 Professional - CA1\hel to Dmitri Popov)
Fie' tot Toos Heb
") Io) i o)+ o






_images/searchreplace.png
File Tools Help

wal7
a

DsxrEeoARORE S ®

Engis!

£ Tools | search

] che

g
ISpa
IS
S
[ et

bl enstyies
bl en-tasks.
b en-templates

en-tooks

chinks.png

rePveniace.png
fL.ong

.png
{peme.png
eme2.png

[ Ep———

Rl e —

£ retmport
Y Worderess
B¢ aIF saeen
4 {7 Reports

4R Tooks
()2 search s Reblace |
Context IDs
@ Screenshots
Global Spelt

é Image Tools

CheckLinks.

check.

Theme Buider
Recorder

Text to find:

Vihole words only.






_images/selguidestyles.png
=
esépng
essipng
tstyle.png
batasks. g
textd.png
getools.prg
rchreplace.prg
I.png

.png
sevtopics.png
nagetopics.png

verview.ong
gorzd
jctsructong
o Gudes
wice

ject

pet |

felp Templates

himl

Select snippet
Placeholder appears.

[T Add numbers to images

Lefttop






_images/selectimage.png
[edttopic31.png
[Cledttopic32.png
[Cledittopic3s.png
[Cledittopic34.png
[Cleditopic3s.png

4 [Clmaces
mﬂ
[shapeedit.png
[simages.png

4 [Cluncategorized
[Fladdiang.png
[laddinkpng






_images/rtftemplates.png
il Tools Help

oEg7z- 8] DaAROREs T eE
Q Templates

githubmarkdown
qude-reatefag
ide-createquiz

4R Tooks

Englsh (United States)

5 search &Replace
o Context s

@ Screenshots
Global Spelcheck.

£5 image Tooks >

B e | +20
(] managetopics.png Name.
] rearange buton . &) defaitrts






_images/resizeimages.png
Fit AllImages To Width (==
Widhelst 200






_images/rtftemplates2.png
File Tools Help

 Englsh (United states)

2)0e0AROEES~ W OE

LE7-Aanes
Q

viite [ Ingert [ Table | Tooks

EEEEE FErERm - HL

£ Image Tooks

o LEVEL1 TEXT
quiz. LEVEL2 TEXT
g R e
I3 HTML-based Templates
P PDFRTF [Print Templates =
) seaitats TITLE1%, b
A0 -
{%TITLE2%,;
R Tods =] {%TITLE3%!
D search aReplace E
o8 conert o0 {%CONTENT%} o
M’“’"‘ Footer (PDF only):






_images/rtftemplates1.png
 File Tools Help

LE/7-800=20020Aa0 0RE & @ @B =wuwsm

Q \Write | Insert | Table | Tools
Tl erones =
] acseviopics.ng
5] achanced-earange.gn
{iE] managetopics.png
‘EI rearrange-button.png
] wovervenong
enwebhep
enworktideo
fagiists. Pages (RTF and PDF
stvimaronn
sde estefaq
qude-ceateqz
P
ae
iz
Uncategorzed
I3 HTML-based Templates ¥
. PDF/RTF [Print Templates

AT defauit.rtf|
=

4R Tooks

= 5 search &Replace

o Context s
Sareenshots
Globalspelicheck

[ »

Footer (PDF onl

£ Image Tooks






_images/screenshots.png
File Tools Help

Engish (United Stat

YEoAROEES ® e

) Tools | Screenshot

(El maintop.png B
{E] newproject0.png
{E] newproject png
(] newproject2png General | Create topics and guides
{E] newproject3.png
{E] newproject4.png

crl+Fi2

© Capture new image

{E] newprojects.png
] mocoptoneong e name fmts [FINGAP R 9377
{E] projectoptions 1.png Category
{E] projectoptions2.png.
{5 variables.png. Image format:
@ Recapture image
- s rame:
——

recapture.prg

screenshots.png
screenshots Lpng
sreenshots2.png

—(—

Tools & Reports

4R Tooks
p Seard| &Replace
o8 comny e

s

£5 image Tooks >






_images/rtftemplates3.png
File Tools Help

O=s>YEeIARNOEEY OO

Englsh (United States)

Bag7s
Q

viite [ Ingert [ Table | Tooks

=] addsevtopics.png
{E] advanced-rearrange.pnc
{&] managetopics.png
l@ rearrange-button.png
{5 uioverview.png
en-webhelp
en-workithvideo
fagists.
githubmarkdown
qude-reatefag
qude-createquiz
o
qhelp

iz
Uncategorzed
I3 HTML-based Templates
. PDF/RTF [Print Templates
T defortr]
B oo

4R Tooks
= 5 search &Replace

o Context s

@ Sareenshots
Globalspelicheck

£ tmage Tooss

DEEEEE @0 - S L

TITLE1%.
{%TITLE2%,;

wermLesv [ e

{%CONTENT %}
GLOSSARY%;






_images/screenshots2.png
File Tools Help

oEg7z- Os>vEe0AROEEY OO

s 2 ) Tools | Screenshot
{i] maintop.png

] revercect.ng dober Givrz s
S E=

(] newproject2png General [ Create topics and guides | Region and Background
{E] newproject3.png

Engish (United Stat

apture active window

) Capture desktop region of an active appication (nduding modal chid windows)

=] mojecoptons2 g
] varabes ng
[ enveports
] revorspn

) Capture entire Desktop
) Capture area around mouse cursor

) Capture only dient area of an active window

PEvl o

w g o

00

[0

Elsomershozng 7] Captre mouse uror

[l capture Backgrounc

Tools & Reports

4R Tooks
x JD search & Replace
g Context IDs Drop Shadow
o) Sreenshots |
obal Spelcheck.
£ Image Tooks






_images/screenshots1.png
{E] newproject2.png
{E] newproject3.png
{E] newproject4.png
{E] newprojects.png
prg

prg

[ enreports
] reports.png

SaeenshoLong
{&] sareenshots2.png

Tods
= 5 search &Replace
o Context s
@ Saeenshots
Globalspelicheck
£ tmage Tooss

) Tools | Screenshot

Hotkey: ol +F12

Bs>VEe0ANOEEY @@k

General | Create topics and guides

Regon and Background

Engish (United Stat

Create topic

|_|5I7 Append to topic:

| create quce:
Append To Guide:






nav.xhtml

    
      Table of Contents


      
        		
          <no title>
        


        		
          About
        


        		
          Benefits
        


        		
          Tutorial
        


        		
          Starting a new project
        


        		
          Capturing screenshots
        


        		
          Adding callouts
        


        		
          Writing topics
        


        		
          Creating a tutorial (a step-by step guide
        


        		
          Compiling a help file
        


        		
          Support
        


        		
          Order
        


        		
          How to…
        


        		
          Start a new project
        


        		
          Import existing documentation
        


        		
          Capture screenshots
        


        		
          REcapture screenshots
        


        		
          Add annotations to screenshots
        


        		
          Quickly update screenshots when UI changes
        


        		
          Create step-by-step guides
        


        		
          Create CHM help file
        


        		
          Create PDF and printed manuals
        


        		
          Create WebHelp
        


        		
          Create QtHelp
        


        		
          Create JavaHelp and OracleHelp
        


        		
          Create EPUB and MOBI ebooks
        


        		
          Embed Video from YouTube, Vimeo and etc
        


        		
          Change order and hierarchy of topics quickly
        


        		
          Create a FAQ
        


        		
          Create a Quiz
        


        		
          Getting Started
        


        		
          UI Overview
        


        		
          Project Structure
        


        		
          Output Formats
        


        		
          Project
        


        		
          Variables
        


        		
          Storage Modes
        


        		
          Topics and Content
        


        		
          Manage Topics
        


        		
          Classic Toolbar WYSIWYG Editor
        


        		
          Tabbed Toolbar Editor
        


        		
          Styles
        


        		
          Text and Paragraph Styles
        


        		
          Table Styles
        


        		
          Shape Styles
        


        		
          Guide Styles
        


        		
          Manage Glossary
        


        		
          Images
        


        		
          Managing Images
        


        		
          Image Editor
        


        		
          Using Images
        


        		
          Cloned Images
        


        		
          Paste from Clipboard
        


        		
          How to Work With Video
        


        		
          Step-by-step Guides
        


        		
          How to create a step-by-step guide
        


        		
          How to use guides in topics
        


        		
          Text Snippets
        


        		
          How to use text snippets
        


        		
          Code Snippets
        


        		
          How to use code snippets
        


        		
          Code snippets in help files
        


        		
          Templates
        


        		
          HTML-based Templates
        


        		
          PDF/RTF/Print Templates
        


        		
          Tools
        


        		
          Search and Replace
        


        		
          Context IDs
        


        		
          Screenshots
        


        		
          Global Spellcheck
        


        		
          Image Tools
        


        		
          Check Links
        


        		
          REImport
        


        		
          WordPress Theme Builder
        


        		
          GIF Screen Recorder
        


        		
          Reports
        


        		
          ToDo List
        


        		
          Formats
        


        		
          CHM
        


        		
          PDF/RTF
        


        		
          Classic WebHelp
        


        		
          Analytics and Social Integration
        


        		
          Adapt to your website
        


        		
          How to Change Style of the Left Pane
        


        		
          WebHelp 2
        


        		
          Printed Manuals
        


        		
          QtHelp
        


        		
          JavaHelp
        


        		
          EPUB
        


        		
          MOBI
        


        		
          OracleHelp
        


        		
          HelpGUI
        


        		
          MajorMindHelp
        


        		
          Wordpress CMS
        


        		
          Knowledge Base
        


        		
          Understanding Profiles
        


        		
          GitHub-flavored Markdown
        


        		
          SimpleDocServer
        


        		
          LiteHelp
        


        		
          LeanPub
        


        		
          Advanced Topics
        


        		
          Conditional compilation
        


        		
          Command line tool
        


        		
          Organizing text reviews
        


        		
          Batch Compile
        


        		
          MajorMindHelpViewer
        


        		
          Localizing help files
        


        		
          Multiple languages
        


        		
          Language strings
        


        		
          XML Import/Export
        


        		
          Quizzes
        


        		
          Quizzes Editor Overview
        


        		
          How to Embed a Quiz
        


        		
          Sample Quiz
        


        		
          FAQ Lists
        


        		
          FAQ Editor Overview
        


        		
          How to Embed a FAQ
        


        		
          Sample FAQ
        


        		
          Quiz Answers
        


      


    
  

_images/reports1.png
Englsh (United Stat

[ParamValue

Date [7/1/2019 825:18 P!

[Parameters

[ 1. Topic Titles and IDs

) [Context
1))
labout 10
i 20
v rutorial 0
support 140
Jorder 0
2 lhowto 830
tartanewproject0 840
| SR mportexistingdocumentation 850
1] rojectstats El
~ canfrescreenshots. RE0. 2






_images/reports.png
[EAN

0]
@)
F:]

)

File Tools Help

ugs-
Q

DsxrEeoARORE S ®

(7 Reports

{E] newproject0.png
{E] newproject png
{E] newproject2.ong
] newproject3.png
{E] newprojectd.ong

Englsh (United Stat

{] TopicTitles and IDs
‘Shows table containing iear st of topic ttes and corresponding IDs.

] Empty Topics

o
g Tmetrne _
EC—

0] Projectstats

‘Shows shows different project statistics, ke topics, images, wordcount and etc.
] TopicStructure
Displays topic sructure in printable form.






_images/tutorial-editor-after-hyperlink.png
Tools  Help

LEI7-A0B=s>YEe0AN O EY © e

Wite |insert | Table [ Took |
BIUS@EEEE=:@E% 0 - %6 L v
T omaltext < T cran -

I O R P e T R e T

MiniKanban is a personal desktop Kanban board that allows to connect board items
with files and folders on your PC.






_images/eng-ed-notes.png
General | ToDo | Notes [ anchors.

“This topic should serve a5 an ntro.






_images/tutorial-project-variables.png
BelER0AR

[ project Options
H iniarban =
4[] Topics General | Templates | Variables | webtiep
About >
t Varizbles (For All Languages) | =
order Varible Valoe 5
4 {1 cetting Started = PROGRAMNAME Tiniarbar] (]
B e trens VERSION 0
i sed COMPANTINAME MajorVind Softnare
Add Board Item YEAR 2018, ad
Move tems between cok.
/st + =

Variables (Language Specific)

Valve

Modfied






_images/eng-ed-insert.png
i s~ =

(5 A @ B Ry

Screenshot / Figure Snippet Code Step-by-step Video Aside/Admonition FAQ Quiz Answers

[ O TR TR R TN CERRS s IS IR RS RN TN ERR - IR RE = TR

Isoftware project themselves. It relatively inexpensive and not as bloate

Helpinator is  sin| ile CHI Help (Classic and New WebHelp2). Mobile. GitHub-flavored Markd
JavaHelp, Oracl le source. You can even create software documentation WordPress themes and publish your online docur

friendly environment.
tor i multiingual You can have as many project languages s you wish. Work with any translation senvice you wish using XML Impor/Export.”

Check the complete list of benefits on our website:






_images/tutorial-editor-glo-hyperlink.png
Displayed e

Kanban

Topic. [ Inemet | Glossary

Ex. Fil.

Atiachment
Board
Checkist

Tag

Cancel






_images/eng-ed-table.png
oAapQEEs W e

Wiite | Insert | Teble [Tooks

i} [} -] i i & & ¥ B

Insert Table Table Properties Merge Cells Split Cells... Insert Column Left Insert Column Right Insert Row Above Insert Row Below  Delete Columns Delete Rows

Englsh (nted Sates)

FEN R N EE R RN RIS Ry X R RS RS RS - ONRS € EN R E RS LR TR VRS - NI CEN R ENRT RN R+ TR R RN RE - IR

Helpinator is a help authoring tool for teams and individuals who document their software project themselves. It relatively inexpensive and not as bloated as big:

Helpinator is a single source tool. You can compile CHM, PDF, RTF. DOCX, WebHelp (Classic and New WebHelp2). Mobile, GitHub-flavored Markdown. Pr
JavaHielp, OracleHelp, HelpGUI all from single source. You can even create software documentation WordPress themes and publish your online documentation
Helpinator is a WYSIWYG tool. Write content in fiendly environment.

tor is multiingual. You can have as many project languages s you wish. Work with any translation senice you wish using XML Impor/Export.”

Check the complete list of benefits on our website:





_images/tutoriallitehelpguide.png
1. Click to add a new task

& MiniKanban vi1.1 - CAMyLife\kenbanbosr kan (Regitered t: Elon Musk)

File Board Help

LEHe

Click on free space in a column or select Board-Add task.






_images/eng-ed-skip.png
General [ ToDo_|[ Notes [ Anchors.

© Never sip

(© Sk when conditon s FALSE:
® Skip from formats:

© skp aways

HelpGLI Github Fiavoured Markdonn






_images/tutoriallitehelpglossary.png
Glossary

Board
Board is a virtual representation of a real lfe kanban board. Consists of
columns and optionally swimlanes (not implemented in this version).






_images/en-workwithvideo1.png
Tools  Help

iﬁwm@\@\o

{E] createchm.png A
{E] reatechm1.png

{E] reatechm2.png

{E] createchm3.png

{E] reatechm4.png

{&] enindie1.png

@‘ projectstruct.png

Engish (United Stat

o
wtepinator
4.5 HTMpased Templates
[5] cefaulthtmi

&) cetoertt
Tass 5

Log

“ il v

+ { Reports =
] Topic Tites and s
] Empty Topics:
[ asks by topics
[ project stats
1] opic structre

i)






_images/tasksbytopics.png
07- 8002 VB2 0A0DEE & @

{J Tasks by topics

© @

[Parameters

[ParamValue
Date[7/1/2019 82609 P!

1. Tasks by topics

[Topic [Tasks PPriorityCompleted
About Update *About” 1
Manage GlossarylAppend lossary example s






_images/en-workwithvideo.png
1] contextid.png
] magetoos g
{E] searchreplace.png
] spelong
] ook

[ o
] acseviopics.ng
5] managetopicspng

= atebzong
- Uncategrized
&) eniindesong
] pojectsiuct o
08 step-by-step Guides.






_images/styles5.png
| File Tools Help

=IVE LR &[] @ 6 oo
@
+H reprator
o] Topics:
o Sties
445 mages
4 (b enstyes
] selguidestyies.png
5] sebhapestyie.ong
1] sekhapestyieLong #container .3s(overflow:nidden; zoom: 17
1] sekablestyle.ong #container .carousel, m
] selablestyleLpng #container .carousel .carousel-wrap(ma|
= stylesong #container .3s .carousel-wrap{display:
= strestong -IE #container .3s .carousel-wrap{disp
] stries2o0 #container .carousel ul(margin:0;paddi
] stylessong #container .3s ul 1i{overflow:hidden:d
] striestong #container .carousel .carousel-control|_
1] styless.png #container .carousel .carousel-next{ba

] textstye.ong #container .carousel .carousel-previon|

#container .carousel .disabled,#contai
#container .carousel divimargin:0;padd
#container .carousel ul{padding:0;list|
#container .carousel ul 1i{position:re
#container div.center-wrap{overflow:ni)

- #container div.center-wrap div{border:
[\'_Tools & Reports #container div.center-wrap a{margin:0

+ T resars A #container div.center-wrap a.active(zo
s —— #container .carousel-pagination {font:
g #container .carousel .steptitle ({STIT
1] ooty s #container .carousel .steptext {{STEXT

gi=| '

(] roetstats
] Topcstrctre






_images/en-workwithvideo3.png
560" height="315"
src="http: fwnw.youtube. com/embed OO TKNYXP 8" frameborder =T0"

alowfulscreen><iframe>|






_images/textstyle.png
LE/720Ee=0A0

o+
s
4 {|] FaqLie
Pl

Helpinator 3.16 - C:\Projects\helpinator.hp (Registered to Drmitr Popov)
File Tools Help

@l « IOl KA 1S TESE=

/ Styles

FAQ Style (POFRTF print)
Quiz Style (POFRTF prin)

[E[EE[E[EEE]

Normal text

Font:

Background Color:

Subfsupersarpts

Vert, shift: o

praeine i boms )

Underine Color: B

Modfied






_images/en-workwithvideo2.png
[E=8 HoR =3






_images/templatenodes.png
File Tools Help

ugs-

DsxrEeoARORE S ®

Engish (Unted States)
7 5] HTML-based Templates
] quistong B
{E] auzzesnode.pg +a=(27
4+ Uncategorized
] aeatechm.png Name
] aeatechmt.png 15] defauthml
& geatedmz.png 18] defaitnebhelp2 himl

{E] createchm3.png
{E] reatechm4.png
{&] enindie1.png

16 epbmobi-defauit bt
18] avahelp-defauit.html
Jol ettt hinl

Bl o/

+ ) PoFRTE Pt T
@) detautertt o
Do &

“ il ’

R Tooks
D search aReplace
58 ContextIDs.
e
v
{E5 Image Tools -






_images/eng-ed-anchors.png
General [ ToDo [ Notes | Anchors |sicp topic [ HTML.

1D toreference this
Name. D 7ol anchor fiom your app f it @
) edtoranchors. 1208 B

Listof anchors in tis topic

Edtand delete






_images/tutorial-editor-1.png
Tools  Help

LE7-08=s20Er0ANOEES T 08

Write [ Insert | Table | Tools |
([ BEEE0 =@ R0~ ®L

About = =
T wa T el
Order
4T] Getting Started
Mirianban v.1.1-CMyL
Main Menu MiniKanban is a personal desktop Kanban board that allows to connect board items.
Toobar with fles and folders on your PC.
4] Tutorl
Add Board Item
Mo items hetwsen cok ™
i v

I O R P e T R e T

4R Tooks =
D search aReplace






_images/eng-cond-text.png
{81 EDITION=PRO'S}
This text will be shown only when EDITION variable is set to PRO'

($Ends}
(§Comment$}

This is comment. It wont be shown anyway

{$Ends]






_images/tools.png
File Tools Help

uwg7

B=s>0)E0ANDEE S| GO o

A Tools
{&] remport.png
] searchveplace.png > search Replace
] spell.ong in
S ‘Search and Replace tool for al topics in the project.
(=] wetheme1png o Contextms

Edit Context IDs of al topics.
o) Screenshot
Take screenshots of acive windows apply effects and save them to the image brary.

“  Global Spelicheck
‘Spelcheck a topcs in the project.






_images/eng-ed-general.png
General [ToDo_| Notes

D to connect your app Generate Context D
with CHM help fle

TopicName:  About

about Context
| Unique topicidentfier

Keywords: elpinator Keywords dialog






_images/en-javahelp1.png
m

Step-by-step Guides

‘Step-oy-step quides sllow you o document procsdurss that sers have to fol
bt s 8 good ides to limit yoursel 1o 10-15. Each step has:

1. Tite

2. Descriptve text sbout actions to perform on this step

5. Imsge from projects Image Library. You can use plain imsgesiscreen|
then you might want o use cloned imsges fo steps.

Helpinator stores sl guides in place smilsr o Image Library.

© File Tools Help






_images/styles2.png
D=2 E20A0I0RIE S OO s
]
1 )
Border color: [ srooo0s [
Light border color: sz [
Border stye: [Reised 30 border, with et
FAQStyle (POFRTF/Print) el border wicth: i 5
Qs shie CERTTPIg Cellborder colrs W sroos [5]
Cellight border color: sz [
Cell border style: [Sunken 3 border, with de.
Cellspzeng: 2 3
e —=
P repors =
] Topic Ttes and 0.
] Empty Topics
(] Tasisby topes
{ Projectstats &
{0 Topic structre -l | i v






_images/styles1.png
Tools  Help

LEZ7-A00=s20E820A0 0EE&| OO s

Algoment: et

i
:
©

Leftindent: o

[EE]

Right Indent o

[EE]

FAQStyie (PDF/RTF Print)
Quiz Style (PDFRTFPrint)

Space Before o

[EE]

[EE]

Space After o

Line Spacing Type: [Percent

4 (]l Reports: - Line Spacng: w

] Topic Tites and s
{] Empty Topics.

] Tasks by topics
] project stats

1] opic structre

<[






_images/en-kindle.png
P Kindle Previewer - Helpinator =) @]
Fle View Goto Devices Utites Help

B A4 @D W[ EaAa- ICEl

Kindle Paperwhite | Kindle | KindleDX |

Table of Contents
+ About
+ Benefits
« Tutorial
- Support
+ Order
« Getting Started
- UI Overview
- Project Structure
- Start a new project
- Output Formats
- Project
« Variables
+ Storage Modes
« Topics and Content
- Manage Topics
+ WYSIWYG Editor
- styles
« Text and Paragraph Styles
« Table Styles
+ Shape Styles
« Guide Styles

1% locations 3 -12 692

1% « B 30f692

EX3)






_images/styles4.png
File Tools Help

OEE & W @ o vmwse

Background Color: - T
Srder Colors I so0000000

eviaten Font Coler | B

Navigation Active Color E

Navigation Background

N—— o a
e i Textbutton
g ] Topic ites and 0s. © E
] Empty Topics:
{] Tasks by topics
] Project stats.
] Topic structure






_images/en-javahelp2.png
File Options

Y

glo &

e [sovaip

®

®5Fomts

® 1 uren
oy

gl (fom Whiscta s bt an splication and ot o anine

e vt oa s itayad o o TR eowss (1 it

@ 1 Output Formats. Java, and is mainly used in Java applications. It can be used for any

® 100 ot and o e e vness o o 1 o o

o150

® 1 Tenpites

The fle format s XML

The GUI uses a -pane lsyout, with 8 oolbar and menu s ihe top,
navigation pan on the et and content viewsr on the ight. The
navigstion pane inclucdes searching, indexing, snd s table of contents.

Officil website: U

[

Helpinator alows you to creste al required HTML snd project files and.
‘sutomatically calls comiler that creates help file in JAR format.

To comil

1. Download and insall JOK. >






_images/styles3.png
File Tools Help

wal7- B> 0EROARN DGR & W @8 s
Ve = / Styles
<l e A
(L] Topics o +z2=
o/ Sties
S =
{2 Glossary -
=) e Badground Color: ] S0000FFFF [ ]
4 [ Code Snippets Line Color: | EE
L Jr— B
b s :
= bt =
{i] batchcompile2.PNG.
(] batchcompie3.PNG FAQStyie (PDF/RTF Print) -
{iE] batchcompile4.PNG. ‘Quiz Style (PDFRTF [Print)
Name: Tahoma )
Size: 8 5
soie:
Colos W oo 5]

< Ol e E [ vpeetenapee 1
] Topic Tites and s Lpdote
] Empty Topics:
] Taks by s

(] roetstats
] Topcstrctre






_images/selshapestyle1.png
7 2HEvAa O

= usesrip 4 |
=] usesnip!

L S

Engish (United States)

1L t iR

ng-textsr
=] edittex

u.xkpm.nﬁs

Shape | Stle | Options | Hyperink|

Shape Sue:

Red and Yelon

Style

i Sold Bordkr: [Sold

Colrs

Body:

s [






_images/selshapestyle.png
DAC OO S|






_images/snippdf.png
Helpinator 3.7 Manual

pas, rtf, webhelp, print"/>
<metaname="cesoription'values
create Cii =
features."/>
<title>Tour on Helpinator</title>
<style>
.tourstep {

width: 890px;

height: 250px;

Help au
es, manuals in EDF format, pr:

tool. Take a tour. Le
nted manuals and other

i

.touring
width: 50%;
float: left;
margin-to;

10px;






_images/snipchm.png
<html>

<head>
<meta nane="keywords" valu

<meta nane="description” value="Help authoring tool.
<title>Tour on Helpinator</title>

<style>

“tourstep {

width: 890px;
height: 256px;

¥

~touring {
width: se%;
Float: left;
margin-top: 10px;

¥

~touring ing ¢
width: 400px;
height; 136px;
border: Spx solid #44040;

¥
Ltourtext {
width: se%;
margin: © 50%;
padding-1eft: 15px;
¥

~toursplit {
background-color: #030303;
height: 15px;
width: 85%;
margin: 15px auto;

¥

<Ustyles

helpinator, help tool, help authoring tool, chm, pdf,

Take a tour. Learn how fo cré





_images/steps.png
| +u-000
s

Ey

A

reordersteps






_images/spell.png
File Tools Help

Q Tools |/Global Sy
o e e
Word Acton Suggestons_Topics
Repace  Software  About
Repce e abol
Repece ool sbol

4] Tutorl
Task 1
Task2

7 Keyworcs

2 Glossary

&) tnsges

[ og

5 search &Replace
o Context s
Saeenshots

£ imageTods
& Geine

- REImport

AV WordPres Theme suider
B GIF Screen Recorder

4 £ Reports






_images/styles.png
Engish (United Stat

2 E 2 ven

Normal text

4 -[2, Text Snippets Font: Arial
= waring
4[] Code Snippets Color: - <FFo00008 IZI
) helginator htrl
+ 5 mages sty =
1 advenced
] betchcompie G Szer o B
] betchcompie 1P1G
] betchcompie2 1 L pefat
{E] batchcompile3.PNG. FAQ Style (PDF/RTF /Print)
] betchcompies G Quz Ste POFRTFPrin) Subfsuperscrit e —
] edytorkeynords NG
] eng-condtext g scae: T
] keywordseditor2 NG

Background Color: =

] kerwordsedars G Spacng: B
S Vert, Shift: T B
Underine stk T —
‘g P o s and s i Underine Colr: =

] Emoty Topies
{] Tasks by topics
[ project stats
T Toic Structure






_images/en-createqt3.png
CHM (Language Specific) [cefau
Webrielp Template (Language Specific) [cefau
| | R Tempate (Language speciic) [cefau
PDF Template (Language Specific) [cefau

Print Template (Language Specifc)
Qielp Templte (Language Spedific

H






_images/en-createwebhelp.png
aeatepdf
Gesteathels
nbedvideo
nportexstngdocs
nemprogect
usesnopet
4 vdeo

] Aboutepnator

2R Too
B search smepiace
55 Context Ds






_images/en-createqt4.png
YEH=s0AMm

et s do [T —
port existing documentat About
plure saeenshots Defauit Font:

‘Arial, 8, DEFAULT_CHARSET





_images/en-createwebhelp2.png
= SR
16/ javahelp-defauit.htmi
7 Notame.ninl

© Buitn:
e
For: CHM, HTWL, QTHELP

© From il

Preview

, 1IT Ovarsiotar






_images/en-createwebhelp1.png
m| ¢ Ee|E

] HTML-based Template:

1e] ed\pmob-efuithinl
16/ javéhelp-defauit.htmi





_images/en-createwebhelp4.png
ojects\helpinator.hpz (Registered to DmitriPopoy)
HEe=soapmaE

[ Project options

General [ Templates | Variables | W

Project Tite:
Heinator

Defauit Font:
‘Arial, 8, DEFAULT_CHARSET





_images/en-createwebhelp3.png
AUES O I _RALVIA 4

[ Project options

General

Tempiates

Varisbles.

CHM (Language Specific)

Webrielp Template (Language Specific)

Print Template (Language Specific)

Qttiep Template (Language Specific)

Javatielp Template (Language Speciic)






_images/en-embedvideo1.png
E]






_images/en-embedvideo.png
Video Name:

<iframe width="560" height="315"
src="http: fwnw. youtube. com/embed OO TKNYXPT8" frameborder=T0"

alowfulscreen></ifame>






_images/en-javahelp.png
< Order
435 Getting Started.
€5 Project

425 Topics and Content.
£ Styles

< Manage Glossary.
€55 Images.

457 Step-by step Guides
-5 Text Snippets

€5 Code Snippets.

& Templates

€5 Tools.

< Reports

<> ToDoList

£ Formats.

Helpinator is & help authoring too for tssms and individuals who dosument.
tneie sotware project themselves. It elatively inexpensive and not 55
blosted as big tech witing packsges.

Helpinstor is & single sourcs tool. You can compils CHI, PDF, RTF,
WebHelp and Printed Manusis sl rom single source

Helpinstor is & WYSIWYG tool. Wrte contentin iendly snvironment.

Helpinstor is multlingusl. You can have ss many project languages 82 you
wish. Work with any fanslation sevioe you wish using XML ImporUExport”

(Check the complate st of benefts on our website

it helpinstor com/bensfit hml






_images/embedquiz.png
wite

] (=N
Bicture... Screenshot /Fiqure Snippet Code Step-by-step

A @[5 B~

ideo  Aside / Admonition FAQ |fuiz| Answers

Insert New Quiz...

Xt DI ENRE AR R RS IR T ERRS IR EZARS

e | B2






_images/embedFAQ.png
Viite | Tnsert | Table | Tooks

(= A [ORIE

Pictus ippet Code Step-by-step Video Aside/ Admonition | FAQ] Quiz Answers
Insert New FAQ..

X 7 main






_images/embedvideo1.png
‘=] en-indle1.png

{E] projectstruct.ng
488 Step by-tep Guides.
capturescresnshots.
areatechm
aeateguide
importexistingdocs

newproject






_images/embedvideo.png
[¥]share with playlististarting from  current video

15" src="htips2/www.youtube.

SHOW MoRE





_images/embedvideo3.png
o] Aside / Admonition

authorin





_images/embedvideo2.png
torhpe (Regsterd o DmiiPopov)
I +llo]l<

J@@OAI

E]






_images/en-createqt.png
(reateguide
createpdf
embedideo
importexstngdocs
neuproject
usesnippet
4 vdeo
E Aboutieinator
4 1o, HTML-based Templates |
[§] defaithimi
epubmobi-efait il

7 Notame.h

) PoRRTEP

) cefouttrts
4R Tooks

5 search &Replace

o Context s

o) Screenshots






_images/embedvideo4.png
(= A @ B Ry

Picture... Screenshot / Figure Snippet Code Step-by-step Video Aside/Admonition FAQ Quiz Answers

elpinator. Promo - CHM, PD!

+/ SCREENSHOT TOOL AND MORE...

v B‘Hﬂ USER TEMPLATES!

* +/ SUPPORTS ALL POPULAR FORMATS!
L d

v/ WYSIWYG EDITOR!






_images/en-createqt2.png
# NoName. html

© Buitn:
e

For: CHM, HTML, QTHELP

© From File: !

Preview

, UI Overview
-





_images/en-createqt1.png
m| ¢ Ee|E
] HTML-based Templates

Fx=[27

Name
(& defauthont

6] e el i
16/ javahelp-defauit.htmi

Ftme i





